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OBJECTIVE: This step-by-step guide introduces the Spatial Qualitative Risk Analysis method
intended for any country wishing to monitor and control foot-and-mouth disease using a
risk-based approach. Foot-and-mouth disease (FMD) is used as a model, but this approach is
applicable to other Transboundary Animal Diseases.

AUTHORS: Hammami Pachka, Arsevska Elena, Poujol Gabriel, Métras Raphaëlle, Coste Caroline,
and Squarzoni- Diaw Cécile; UMR Astre-CIRAD, France.

FINANCIAL SUPPORT: The European Commission for the Control of Foot-and-Mouth Disease
(EuFMD) is one of the oldest commissions of the Food and Agriculture Organization of the
United Nations (FAO). Since 1954, the EuFMD has been working with European countries
and their neighbours to improve preparedness and reduce risk connected to FMD introduction
and spread through the establishment of sustainable control programs. The disease is currently
circulating in the neighbourhood of Europe, in over 100 countries in Africa and the Middle
East, and across vast areas of Eurasia. In 2017, EuFMD and CIRAD (the French Agricultural
Research Centre for International Development) signed a partnership agreement aiming at
improving identification of risk areas connected to animal mobility and other risk factors. The
scope is to enhance FMD surveillance and control in the European neighbouring countries
of North and West Africa. Within this agreement CIRAD contributed to the strengthening
of veterinary services’ capabilities through training courses on the development of FMD
surveillance programs based on the analysis of health hazards and the use of Geographic
Information Systems (GIS).
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1. Introduction

Foot-and-mouth Disease

Foot-and-mouth disease (FMD) is one of the most contagious viral diseases in susceptible animals.
It affects cattle, pigs, sheep, goats and other cloven-hoofed animals. Able to induce close to 100%
morbidity in susceptible populations, the economic impacts of FMD epizootics are devastating.
FMD is endemic in most parts of mainland Asia, Africa and the Middle East. Most countries in
South America have applied zoning measures and are recognized as being free of FMD with or
without vaccination by the World Organization for Animal Health (OIE). Australia, New Zealand,
Indonesia, North America and Western Europe are today (2019) free of FMD.

While the disease is rarely fatal in adult animals, mortality is frequent in young stocks due to
myocarditis or a lack of milk if the mother is infected. The disease is characterized by hyperthermia
and induces sores on the nose, in the mouth, and on the hooves and teats. It causes heavy production
losses, and although most animals survive the disease, it often leaves them very weak.

The virus responsible for FMD is an aphtovirus, member of the family Picornaviridae. Present
in all excretions and secretions from infected animals, the virus can be detected in milk and semen
up to four days before the first clinical signs appear. Animals that recover from the infection can
carry the virus. Infected animals exhale large quantities of the virus in the form of aerosols that can
infect other animals via the respiratory tract or orally.

The severity of FMD is due to the rapidity by which the virus spreads. The disease can be
introduced into and transmitted within a herd via the following:
• introduction of new animals carrying the virus (in saliva, milk, semen, etc.);
• use of contaminated pens, buildings, or vehicles to house and transport susceptible animals;
• presence of contaminated material such as hay, feed, water, milk or organic products;
• wearing of contaminated clothes or shoes, or the use of contaminated equipment;
• feeding of susceptible animals with virus-infected meat, animal products, or raw or improperly

cooked feed;
• spread of the virus from infected premises via air-borne aerosols.

There are seven serotypes of FMD virus (A, O, C, SAT1, SAT2, SAT3, Asia1), each of which
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requires a specific vaccine strain to ensure the immunity of a vaccinated animal. FMD can be
controlled or even eradicated through vaccination, animal movement control, quarantine and
slaughter of infected animals, as well as the effective removal of contaminated carcasses and animal
products. Biosecurity and disinfection are crucial to limit the spread of the virus.

FMD is on the list of notifiable diseases in the OIE Terrestrial Animal Health Code and must
be reported to the World Organization for Animal Health (OIE). However, FMD surveillance
and control activities are resource demanding. In endemic countries where financial and human
resources allocated for animal health are limited, FMD surveillance and control measures should
be designed and implemented in a risk-based approach.

Objectives of the proposed framework

To optimize FMD national surveillance and control systems in North Africa and West Africa,
CIRAD developed a qualitative framework to analyse and map the risks of FMD introduction and
spread (Squarzoni-Diaw et al., 2020).

This method is based on the collective expertise of national, regional and international experts
and uses free and open source software. It aims to provide elements to assist decision-making
by national veterinary services in order to help them set up less expensive and more effective
risk-based surveillance and control protocols of transboundary animal diseases.



2. Tools and main principles

The framework described in this instruction manual was developed by CIRAD researchers with
different fields of expertise: epidemiology, veterinary science, ecology, animal mobility, mapping,
etc. In this chapter, we briefly introduce the theoretical basis that served as the foundation for the
development of this qualitative risk analysis framework applied to animal health.

2.1 Animal health surveillance

Infectious animal diseases, including zoonoses, can have serious economic and public health
consequences. In general, they pose a major challenge for health authorities, who must ensure
disease surveillance and organize prevention and control actions.

Epidemiological surveillance is a method of observation based on the continuous recording of
epidemiological data, rendering it possible to i) monitor the health status or risk factors of a defined
population, ii) detect the emergence of a disease, and (iii) study its evolution in time and space with
a view to the adoption of appropriate control measures (Dufour et al., 2006).

An epidemiological surveillance “mechanism” or “system” is an activity or set of activities
aiming at systematically collecting, analysing and disseminating health data to plan, implement and
evaluate public or animal health programs. Depending on the final goal and the means available,
surveillance can be conducted through the use of virological or serological tests (serosurveillance).

Among the different existing surveillance methods, event-based surveillance is used most often
for FMD surveillance because of its low cost. However, as programmed surveillance has been
shown to be more effective in detecting new cases, alternative approaches have been developed
that optimize the effectiveness of surveillance, notably when resources are limited. One of these is
risk-based surveillance, the framework presented in this guide.

Event-based surveillance (also known as clinical or passive surveillance) This is the approach
used most widely around the world. It is based on the detection of clinical signs of disease and/or
abnormal situations by farmers and/or veterinarians who are in contact with animals. For example,
a farmer tells his veterinarian that he has observed the clinical signs of FMD in most of the animals
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on his farm, notably fever and the presence of vesicles on the nose, mouth and hooves. This type
of surveillance enables national agencies to identify the emergence of disease outbreaks and to
organize control measures.

Programmed (or active) surveillance is based on a previously established sampling plan. For
example, the implementation of serological surveys in risk areas or throughout the country to
detect the circulation of a virus before clinical signs even appear. This type of surveillance enables
national agencies to be proactive in the identification of subclinical cases and to prevent the spread
of the virus by rapidly setting up control measures.

Risk-based surveillance consists of determining spatial and temporal discrimination criteria
to focus surveillance efforts on targets and/or periods of higher risk for the introduction and/or spread
of a disease and to concentrate surveillance activities in these areas. This approach, recognized as
more effective than event-based surveillance, aims to optimize economic and human resources, and
thus increase the effectiveness of surveillance when resources are limited in the field. It responds
effectively to certain surveillance objectives, such as proving that a territory is disease-free or
detecting the introduction of a disease as early as possible. This organization of epidemiological
surveillance activities makes it possible to adapt to previously defined objectives, which can be, for
example, early detection of disease emergence, estimation of prevalence, ranking various diseases
according to their importance, proof that a region is disease-free, or evaluation of control actions.

Some application examples:
• Risk-based surveillance protocol described in FAO’s pamphlet n˚1, “Addressing avian

influenza A (H7N9)” (FAO, 2014). This protocol was developed to maximize the probability
of detecting the circulation of low pathogenic avian influenza (LPAI) A (H7N9) virus in
birds.
• Recommendations for surveillance protocols in the state of Rio Grande do Sul in Brazil

following the identification of major risk areas for the introduction and dissemination of
FMD (Santos et al., 2017).

This type of surveillance must be based on in-depth preliminary studies of the risk factors specific
to each disease and the agro-ecological and social context of the territory of interest. This guide
introduces a qualitative risk analysis framework enabling veterinary services to optimize their
national surveillance systems in order to implement targeted surveillance in areas at high risk of
introduction of, and/or exposure to, the FMD virus, whether to facilitate the early detection of an
incursion of the virus in disease-free countries or areas, or to optimize crisis management in the
event of an epizootic by promoting risk-based control programs.

2.2 Qualitative risk analysis

Risk analysis is a decision support method that, according to the OIE, includes hazard
identification, risk assessment, risk management and risk communication. Applied to animal
health, this method makes it possible to identify epidemiological risk factors, define levels of health
risk, and facilitate health decision-making. In so doing, it aids the implementation of relevant risk
surveillance and control measures, and facilitates communications at all levels of the process, as
well as with different animal health actors, from farmers to public services (AFSSA, 2008).

A few definitions in the context of import risk analysis:
Hazard identification: Identification of pathogens that may be present in live animals or animal

products being considered for importation.
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Risk assessment: Assessment of the probability of a hazard’s introduction, establishment and
spread over the importing country’s territory. This assessment can be qualitative or quantitative
depending on the data used.
Risk of release of a pathogen from a source: This depends on, among other factors, the

number of animals or animal products exported from the source; the prevalence
of the disease in the source country; the quality of the veterinary services and the
epidemiological surveillance network in the source country; and possible control
measures implemented in the source country.

Risk of introduction of infected animals or animal products: This depends on the risk of
release of source countries.

Risk of exposure means the risk of endemicity and spread of the pathogen once introduced.
This depends on, among other factors: the pathogen’s transmission mechanisms and
the factors affecting its survival; the potential for contamination in the destination
country; preventive measures in the destination country; and the presence of vectors
and potential reservoirs in the destination country.

Risk management means identifying, choosing and implementing measures that will enable a
reduction in the risk level.

Risk communication is the communication of health information in a manner that will enable the
members of a population to protect themselves (if the disease is zoonotic) and their animals.
Risk communication helps to stop the spread of the disease and limits economic and social
impacts in the event of outbreaks during a health emergency.

Qualitative risk analysis (QRA) QRA is a method of risk analysis distinguished by the qualitative
assessment of risk. Risk is characterized by words rather than numbers, which are used in
quantitative methods (AFSSA, 2008; Zepeda-Sein, 1998). QRA uses a list of adjectives or an
ordinal scale attributing a level to the risk. The probability of the occurrence of an event, such as
the introduction of a pathogen, and the magnitude of its consequences, are therefore not expressed
numerically but in qualitative terms such as “Very High,” “High,” “Low” or “Negligible” (AFSSA,
2008).

In this guide, we use the four risk level qualifiers defined by Zepeda-Sein (Zepeda-Sein, 1998)
for the assessment of both release and exposure risks and for the assessment of the consequences:

Negligible the occurrence of the event is only possible under exceptional circumstances;
Low the occurrence of the event is rare, but it is possible under certain circumstances;
High the occurrence of the event is clearly possible;
Very high the probability of the occurrence of the event is substantial.

QRA is particularly useful (i) when there is not enough information available for the parameters
that need to be quantified, (ii) when there is little time to issue estimation results and make a crisis
management decision, for example in the case of an epizootic, and (iii) as an initial assessment of a
situation when the assumed risks do not seem to justify a more in-depth investigation (Dufour &
Pouillot, 2002).

However, the approach requires a detailed and structured study of every parameter that needs
to be taken into account in the decision. In the context of animal health issues, the parameters
to be identified may be, for example, the source of the pathogen, the risk factors facilitating the
transmission and maintenance of the pathogen, or the quality of the surveillance and control systems
in the exporting and importing countries (OIE, 2007).

The proposed method is based on the sharing of expertise within a group (i.e. by experts’
opinion) and defined as an opinion based on their professional experience. Through its use, the risk
assessment approach becomes explicit and the use of this method leads to a certain reproducibility
of the process. The opinion of the group renders it possible to reach an overall qualitative estimation
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of the risk for a given country.
For further information in English, see:
• FAO manual for the preparation of FMD contingency plans (FAO, 2002) ;
• A qualitative risk assessment method in animal health by the French Food Safety Agency

(AFSSA) (AFSSA, 2008) ;
• OIE’s Terrestrial Animal Health Code glossary (OIE, 2011) ;

and resources in French:
• UNIT. Objectif et typologie des méthodes qualitatives d’analyse de risque par l’Université

d’ingénierie et technologique (Talon et al., no date) ;
• Cardoen, S. et al., 2014. “Radioscopie de la surveillance des maladies animales infectieuses

en Belgique (partie II) : analyse des aspects organisationnels des activités de la surveillance
et recommandations” (Cardoen et al., 2014) ;
• Dufour, B., Hendrikx, P., & Toma, B. 2006. “Élaboration et mise en place de systèmes de

surveillance épidémiologique des maladies à haut risque dans les pays développés” (Dufour
et al., 2006) ;
• Valérie Cortin, Lise Laplante, and Marc Dionne. 2018. La communication des risques à la

santé au Québec (Cortin et al., 2018).

2.3 Analysis of social networks

2.3.1 Animal mobility

Animal movements (via trade and transhumance) constitute a major risk factor for the spread of
animal diseases that must be taken into account in a qualitative risk analysis in animal health.

Information on animal mobility is sensitive and often sketchy because, for the most part, the
movements are undeclared. To take this factor into account, it is also essential to improve the
understanding of livestock mobility, notably in countries of the Global South where dedicated
databases are lacking and where animal traceability is difficult. In the absence of national
identification databases, field surveys on domestic animal mobility at the national and regional level
must be implemented1.

Understanding animal mobility networks makes it possible to predict introduction and spread
scenarios for most vector-borne and directly transmitted animal diseases. In your future studies, we
strongly recommend you consider animal mobility as a major risk factor in the introduction and
spread of transboundary animal diseases.

2.3.2 Analysis of animal mobility

Analysis of social networks

To include animal mobility in a qualitative risk analysis and highlight the movements of groups of
animals which are the most at risk, whether in terms of the introduction or spread of pathogens, we
suggest that you use the principles of social network analysis (SNA) to analyse mobility.

In performing this type of analysis, animal mobility is considered in the form of a network
of entities called nodes (for example, epidemiological units such as sub-prefectures, or animal

1The questionnaires must include the Origin and Destination of each animal movement. Additional questions can
be added to better describe the movement and the population under study (date or period of the movement, number of
animals, species, type of origin and destination, transit, animals unloaded...). These animal mobility surveys make it
possible to capture the major flows and thus to describe and analyse the trade and/or transhumance routes of livestock in
accurate terms.
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gathering points, such as markets, slaughterhouses or livestock farms) connected by links created
during interactions (e.g. trade and movement of animals as part of transhumance).

Mobility parameters

The SNA method is applied by calculating the indicators serving to describe the network (for
example, the degree to describe cohesion or the betweenness centrality to describe the centrality
of the network) (Wasserman & Faust, 2012). From these indicators, one can deduce the specific
characteristics of the network and the importance or the influence of certain nodes.

In this guide, we are particularly interested in the degree (number of links connecting a node to
other nodes), in-degree (number of links going from a node towards other nodes) and betweenness
centrality (number of nodes to which a node is indirectly connected via its direct links). Practically,
a sub-prefecture’s degree indicator will indicate the number of incoming (in-degree) and outgoing
(out-degree) animal movements to and from this sub-prefecture, thereby making it possible to
estimate the intensity of the sub-prefecture’s import/export activities and its importance in the
mobility network. A high degree sub-prefecture will be more vulnerable (high in-degree), but
also will facilitate the spread of pathogens through wider dispersion (high out-degree). Finally,
sub-prefectures with a high betweenness centrality will represent trade hubs which facilitate the
spread of pathogens.

These SNA indicators make it possible to measure “spreadability” and are the most relevant for
our analyses because they highlight the importance of a node in terms of centrality and connection.
Several types of networks can thus be analysed according to the risk, the disease and the territory
under study. We are particularly interested in national networks to study the spread of a pathogen
and international or regional networks to study the risks of introduction of a pathogen.

The collection and analysis of animal mobility information, as well as the mapping of animal
movements within and between countries allow, even without risk analysis, veterinary services to
optimize animal disease surveillance at the national and regional levels.

2.4 Risk mapping

Risk mapping refers to the production of risk maps. A risk map is a complex, computer-generated
image that shows the spatial distribution of a risk. Increasingly used in human and veterinary
epidemiology, risk mapping in animal health generally aims to highlight areas where a given
pathogen is most likely to be introduced (risk of introduction), or the locations where it is most
likely to spread once introduced (risk of exposure). These risk maps are effective means of
communication and can support veterinary services in making health decisions and in setting up
relevant risk-based surveillance and control protocols.

Risk maps are based on the spatial distribution of “risk factors” – elements influencing the
emergence of a disease such as the main transportation routes – and the relative importance of each
of these factors. Qualitative health risk analysis can be combined with risk mapping when one has
spatial data (associated with geographic coordinates) for the major risk factors.

It is important to note that a risk map is a tool that can be extremely relevant in identifying
places where an outbreak is likely to occur, and, combined with field verifications and other tools,
in alerting animal health specialists working in areas vulnerable to the introduction and spread of
specific diseases. Thereby, it helps to spatially define the allocation of resources and to manage
surveillance and control programs by highlighting high-risk areas. However, this tool only indicates
the location of where an outbreak is the most LIKELY to emerge, it can in no way predict the
occurrence of a specific outbreak. Moreover, one must keep in mind that risk mapping only takes
into account a limited amount of data (data which are available, spatialized, up to date, etc.). Every
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risk map also must be discussed and validated by experts in the field and be updated on a regular
basis.

For further information, see:
• Stevens, K.B., et al., 2010. Risk Mapping for HPAI H5N1 in Africa - Improving surveillance

for virulent bird flu: Final report and risk maps. (Stevens et al., 2010)

Geographic information system

Risk maps are produced using a Geographic Information System (GIS). A GIS is a computer tool
designed to collect, store, process, analyse, manage and represent all things located on the surface
of the earth (e.g. animal density, veterinary stations, water points, and epidemiological units etc.)
as well as processes that affect them (e.g. animal mobility). Therefore, it is not only a mapping
tool, it also enables the compilation, study and synthesis of data (e.g. distance calculations) before
representing the data in the form of a map. It is a spatial data management and analysis tool (not
a data collection or production tool). To work with a GIS, you need a computer, GIS software
(e.g. QGIS, MapInfo, ArcGIS, ArcView) and spatial data (with spatial coordinates).

The qualitative and cartographic analysis framework presented in this manual was developed
using the open source software QGIS. If you are not familiar with GIS and/or this software, we
recommend that you go through the starter course, in Chapter 7, page 43. of this manual.



I
3 Principle and objectives . . . . . . . . . . . . . 19
3.1 Principle of Spatial Qualitative Risk Analysis
3.2 Objectives of the method
3.3 Case study: foot-and-mouth disease in Tunisia

4 Risk of introduction . . . . . . . . . . . . . . . . . . 21
4.1 1st step: List the risk factors
4.2 2nd step: Categorize the risk factors
4.3 3rd step: Characterize the risk levels
4.4 4th step: Map the risk of introduction

5 Risk of exposure . . . . . . . . . . . . . . . . . . . . . 27
5.1 1st step: List the risk factors
5.2 2nd step: Categorize the risk factors
5.3 3rd step: Characterize the risk levels
5.4 4th step: Mapping the risk of exposure

6 Risk-based surveillance and control . . 33
6.1 Risk-based surveillance
6.2 Risk-based control

The method: step by step





3. Principle and objectives

3.1 Principle of Spatial Qualitative Risk Analysis

Spatial Qualitative Risk Analysis (SQRA) is a decision support tool that contributes to the better
management of international trade and reinforced health safety. In the field of animal health, we
are focusing on two quite different risks, which require the implementation of different surveillance
and control actions.

3.2 Objectives of the method

The method presented in this manual has three main objectives:

Estimate the risk of introduction of an animal disease related to trade flows (legal and illegal)
and to cross-border movements of animals (e.g. transhumance);

Highlight areas/townships with a high risk of introduction, establishment and spread of this
disease;
Develop and support the implementation of effective and low-cost surveillance and control
strategies.

Based on collective expertise, the proposed Spatial Qualitative Risk Analysis method has four main
steps:
• Identification of risk factors by a group of experts (epidemiologists, virologists, veterinarians,

agronomists, etc.);
• Classification of risk factors by a group of experts (epidemiologists, virologists, veterinarians,

agronomists, etc.);
• Characterization of four risk levels: negligible risk, low risk, high risk and very high risk;
• Risk mapping based on local characteristics.
These four steps are undertaken for each risk analysis. In the following chapters, we will first

examine how to analyse the risk of introduction of a disease, a critical risk to assess for disease-free
countries (Chapter 4). Then, we will look at how to study the risk of establishment and spread of
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the disease (Chapter 5). Following these analyses, we will see how to use the resulting risk maps to
build a risk-based surveillance protocol (Chapter 6).

3.3 Case study: foot-and-mouth disease in Tunisia

Lastly, in Part II: Practical Exercises, Chapter 9, you will be able to practice the method step
by step, following the proposed case study of foot-and-mouth disease in Tunisia. For reasons of
confidentiality, fictitious data are provided for this case study.



4. Risk of introduction

Objective

Estimate the risk of introduction of a given disease on a given territory. This involves identifying the
sources of infection and the associated probabilities of introducing the disease. The identification
of the major sources of infection renders it possible to guide the establishment of risk-based
surveillance protocols for the early detection of potential introductions.

4.1 First step: What are the risk factors for the introduction of the disease
in your country?

The first step consists of identifying the factors that could lead to or facilitate the introduction of
the disease in your country. We are referring here to risk factors.

How to proceed?

Define the risk factors

Gather a group of relevant experts to discuss, within the disease epidemiological context, the
sectors involved, the study area, and the operations of the veterinary services. Consider together the
following questions:
• How could the pathogen be introduced into your territory?
• What could facilitate its introduction?
• Are there pathways of introduction that are more likely than others?

Based on your discussions of these questions and a possible literature review, list the risk factors
that are potentially involved in the introduction of the pathogen into your territory, then decide
together which are the principle ones.

NB When possible, we recommend limiting yourself to a maximum of five risk factors.
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It is important to reach a conclusion validated by all the gathered experts.

Some tips
You can consider three paths of introduction for diseases affecting domestic animals such as

foot-and-mouth disease:
• legal trade;
• illegal trade;
• other animal movements/flows, notably as part of transhumance.

Depending on the country from which the movements or trade originate, the risk is not the same, as
flows from a disease-free country will be less risky than flows from a country where the disease
is endemic. Likewise, flows from a country that has established strict measures for animal health
management (surveillance and control) will be less risky than flows from a country where the
animal health management measures in place are limited. Do not hesitate to draw inspiration from
the exercise undertaken for Tunisia (Chapter 9) and the list of risk factors proposed in Annex 9.2.4.

NB Depending on the country and the sector, mobility can be influenced by flows other than
trade and transhumance. For each analysis, you must carefully study the actors and processes
affecting animal mobility.

Define your work scale

Once you have listed the main risk factors, you must define the scale on which you want to/can
work. The finer the work scale (e.g. township rather than department), the more precise your
analysis will be. You must define your work scale based on the structure of your veterinary activities
and the availability of data. For example, if you only have departmental level data, you will not be
able to work at the township level.

In the following sections of this manual, we will use the generic term, “administrative division”
. Depending on the scale that you have chosen, this can correspond to a region, a department, a
town, a village, etc.

Identify, retrieve and prepare data

Now that you have defined your risk factors and work scale, identify the data related to each risk
factor. Organize/consolidate data to obtain a value or a criteria per administrative division. For
example, if you have chosen to do the analysis at the department level and you have animal density
data by township, you can average the animal density by department so that you have an animal
density value for each department. Have the data validated by field experts, and finally, if necessary,
format the data so that it can be imported into GIS software (csv, shapefile or raster format).

NB A great deal of data is freely available on a worldwide scale; do not hesitate to do online
research or to ask the expert trainers at CIRAD.

4.2 Second step: Categorize the risk factors

Once your data is ready (sorted, reported at the correct scale, validated by field experts and put in
the correct format), you must define the risk categories associated with each risk factor.
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For example, if one considers that the epidemiological status of an exporting country with respect
to a disease is a risk factor for introduction (it is riskier to import animals from a country where
the disease is endemic than from a disease-free country), four risk levels must be defined for this
epidemiological status. These levels could be disease-free (negligible risk); very old circulation
(low risk); recent circulation (high risk); endemic disease (very high risk).

Classifying risk factors related to epidemiological status, surveillance systems and control
systems can be a delicate task. CIRAD experts therefore have developed a generic tool that
makes it possible to assign a risk of release to exporting countries. More specifically, it allows
you to classify/qualify the risk of introduction of infected animals from a country by taking into
account the country’s epidemiological status and animal health activities (surveillance and control)
implemented on the ground. The use of this tool is described in detail in Part II: Practical exercises,
Chapter 9.

For other risk factors, the classification/categorization depends on the nature and distribution of
the data:
Qualitative variables: presence/absence, nearby/distant, few/moderate/many etc. In this case, the

risk categories are fairly easy to define.
Quantitative variables: numerical data (e.g. number of heads per km2, travel time from one area

to another, etc.). For this type of variable, the distribution of the data generally follows a
normal distribution and a categorization into four classes is recommended. The thresholds of
the classes are defined by the quantiles (figure below): negligible risk [0–1st quantile (Q1)];
low risk [1st quantile (Q1)–2nd quantile (Q2)]; high risk [2nd quantile (Q2)–3rd quantile
(Q3)]; very high risk [greater than 3rd quantile (Q3)]. Depending on the distribution of the
data, it is possible that the use of quantiles is not appropriate; when that is the case, you will
have to choose another type of classification.

4.3 Third step: Characterize the risk levels

Once you have categorized your risk factors, you have to combine them in order to characterize four
levels of risk of introduction of the pathogen into your territory (negligible, low, high, or very high);
this is the weighing of risk factors against each other. The risk of introduction levels defined in
this way can be linked to probabilities of introduction (AFSSA, 2008). You are seeking to answer
the following questions:

Under what conditions can one consider that an administrative division presents a very high
risk/the introduction of the pathogen there is very likely?

Under what conditions can one consider that an administrative division presents a high
risk/the introduction of the pathogen there is likely?
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Under what conditions can one consider that an administrative division presents a low risk/the
introduction of the pathogen there is unlikely?

All administrative divisions that do not fulfil any of these conditions present a negligible risk of
introduction; i.e. the introduction of the pathogen via live animals or animal products there is
improbable.

NB You also can use a different approach, directly asking yourself about the risk factors: does the
risk factor α alone lead to a very high/high/low risk? If not, if it was associated with one or
more other risk factors, could the risk could become very high/high/low?

How to proceed?

The characterization of risk levels (weighing risk factors against each other) is always done by a
group of experts (expert opinion).

Exercise 4.1 At the end of the discussions with the group of experts, you should all agree on
how to complete the following text:

“The risk is very high if... , otherwise, the risk is high if..., otherwise, the risk is low if...,
otherwise, the risk is negligible.”

NB The ‘...’ can be filled in with several conditions separated by ‘OR,’ and the conditions can
be defined by a combination of conditions connected by ‘AND.’

�

Exercise 4.2 Based on the information in this text, complete the table below:

Risk levels
Very high High Low

NB Negligible risk does not appear in the table because if the risk is not very high, high, or
low, it must be negligible. Therefore, there is no need to characterize this risk level if the
three higher risk levels are correctly defined.

�

Example
Suppose three risk factors have been selected: borders, illegal/uncontrolled crossing points,

degree of cross-border inflow (an animal mobility parameter highlighting the main destinations of
the flows in an international animal mobility network). Borders and crossing points are qualitative
factors, so each would be categorized into three classes: Country X (Sharing a border with country
X), Country Y (Sharing a border with country Y) and N [No border]; and two classes: P (Presence
of at least one illegal crossing point) and A (Absence). In contrast, degree of cross-border inflow is
a quantitative factor and categorized into four classes: N (negligible), L (low), H (high) and VH
(very high).

The risk is very high if [the degree of cross-border inflow is very high (regardless of other
factors)] OR [in the presence of an illegal crossing point (regardless of other factors)] OR [in the
presence of a border with country X (regardless of other factors)]; otherwise the risk is high if [the
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degree of cross-border inflow is high] OR [in the presence of a border with country Y (regardless
of other factors)]; otherwise the risk is low if [the degree of cross-border inflow is low]; otherwise
the risk is negligible. Please refer to the table below:

The level of risk is...
Very high, if High, if Low, if

In-degree (VH) In-degree (H) In-degree (L)

OR Country X Country Y

OR Ill. crossing point (P)

4.4 Fourth step: Mapping the risk of introduction

You now have all of the information on hand to cartographically represent the data and produce a
risk of introduction map.

What do you need to do now? Review the characteristics of each administrative division
(meaning the different risk factor categories associated with it) to determine the risk level to
attribute to each division. Once you have defined a risk of introduction level for each administrative
division, you can produce a map by colouring the administrative divisions according to their risk
level. It is agreed to respect the following colours (table below):

Risk Colour Code (Hex and RVB)
Negligible Green � #13d604 (19,214,4)
Low Yellow � #ffe74d (255,231,77)
High Orange � #ff8c4a (255,140,74)
Very high Red � #fc3232 (252,50,50)

Example Using the previous example, we will colour in red all of the administrative divisions
with a very high risk of introduction, in orange the divisions where the risk is high, in yellow the
divisions where the risk is low, and in green the divisions where the risk is negligible.

All administrative divisions with a very high degree of cross-border inflow thus must appear in
red on the map. The same is true for the administrative divisions that have a border with country X,
and for the administrative divisions where there is at least one known illegal crossing point.

Following the same logic, among the remaining administrative divisions, those that appear in
orange are:
• administrative divisions where the degree of cross-border inflow is high;
• administrative divisions sharing a border with country Y.
Lastly, among the remaining administrative divisions, those that appear in yellow are:
• administrative divisions where the degree of cross-border inflow is low.
All of the other administrative divisions have a negligible risk of introduction because they do

not have a major risk factor; therefore, they appear in green on the map.
In the practical exercises (Chapter 9), we will see how to use free and easy-to-use tools to

produce risk maps from your data once the four risk levels have been characterized with the expert
group.

Congratulations, if you have successfully completed all of these steps, you have produced a
map of the risk of introduction of an animal disease!!
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If this is not the case, go to Part II to practically carry out a qualitative mapping analysis of the risk
of introduction, using the example proposed in Practical Exercises, Chapter 9. This will allow you

train yourself using fictitious data and the proposed risk factors.



5. Risk of exposure

Objective

Qualify the probability of the occurrence of a local epizootic following the introduction of a
given disease in a given territory. We are referring here to the risks of the disease establishment
(endemicity) and spread over the territory after being introduced. The identification of the areas
most exposed to the disease makes it possible to guide the establishment of risk-based surveillance
protocols for the early detection of potential epizootics.

As the method for the analysis of the risk of exposure is substantially the same as for the risk of
introduction, we suggest that you follow the same four main steps.

5.1 First step: What are the risk factors that could lead to the establishment
and spread of the disease in your country?

The first step is to identify the factors facilitating the establishment and/or spread of the disease
under study on the territory in question once the disease has been introduced. We are again referring
to risk factors.

How to proceed?

Gather a group of relevant experts to discuss within the disease epidemiological context, the
sectors involved, the study area and the operations of the veterinary services. Consider together the
following questions:
• What are the factors facilitating the establishment of the disease?
• What are the factors facilitating its spread?

Based on your discussions and possible literature review, list the risk factors that you have identified,
and then validate those that you would consider to be the main risk factors.

NB We recommend that you limit yourself to a maximum of 5 risk factors.
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It is important to reach a conclusion validated by all of the experts concerning the risk factors
listed and those retained as priorities.

NB You can organize a single meeting to consider the risk factors of introduction and the risk
factors of exposure. However, make sure to clearly differentiate the factors according to the
risk analysis, avoiding repetition.

Some tips
• A disease cannot establish itself without the presence of animals; therefore, always list animal

density as a risk factor;
• The spread of a disease depends on animal movements; therefore, think about different

animal movements (transhumance, farm site 7−→ slaughter site 7−→ sale site etc.) and seek
information sources related to animal mobility;
• The occurrence of an epizootic is more likely on sites where animals are gathered together

than where animals are isolated. Therefore, identify and list the sites where animals are
concentrated (water points, live animal markets, etc.). Note: The types of gathering sites may
vary depending on the sector and national practices.

Define your work scale

Like for the risk of introduction, you must define your work scale based on the structure of your
veterinary activities and the availability of data. However, it is strongly recommended to use the
same work scale for the risk of introduction and the risk of exposure, in order to obtain harmonized
risk maps.

Identify, retrieve and prepare data

As for the analysis of the risk of introduction, for each administrative division, identify the data for
each risk factor, either on public platforms providing open access data (for example, you will find
reliable sources for animal density and accessibility in Chapter 7.2.2 page 45), with state services
(for animal mobility data or “laissez-passer” health certificates), or by conducting field surveys.

Once you have retrieved all of the necessary data, bring them to the scale you defined previously,
meaning you should have a value (quantitative or qualitative depending on the risk factor) per
administrative division for each risk factor.

Lastly, make sure that the data is in a form compatible with the GIS software that you will use
for the risk mapping step (for example, if you are using QGIS, your data must be in a csv, shapefile,
or raster format).

Steps 2, 3, and 4 are exactly the same as in the analysis of the risk of introduction.

5.2 Second step: Categorize the risk factors

As for the analysis of risk of introduction, once your data are ready, you must define categories/classes
for each risk factor.

The classification/categorization again depends on the nature and distribution of the data:
Qualitative variables: presence/absence, nearby/distant, few/moderate/many etc. In this case, the

risk categories are fairly easy to define.
Quantitative variables: numerical data (e.g. number of heads per km2, travel time from one area

to another, etc.). For this type of variable, the distribution of the data generally follows a
normal distribution, so a categorization into four classes is recommended with the thresholds
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defined by the quantiles (figure below): negligible risk [0–1st quantile (Q1)]; low risk [1st
quantile (Q1)–2nd quantile (Q2)]; high risk [2nd quantile (Q2)–3rd quantile (Q3)]; very high
risk [greater than 3rd quantile (Q3)]. Depending on the distribution of the data, the use of
quantiles may not be appropriate; in this case, you would have to choose another type of
classification.

In brief
You must define qualitative classes, both for risk factors that are already qualitative (e.g. one
can choose to define water points in two classes: presence or absence) and for the quantitative
risk factors (e.g. one can define animal density in four classes according to the quantiles, these
classes respectively reflect conditions where one would consider animal density to be negligible,
low, high or very high).

5.3 Third step: Characterize the risk levels

The risk factors must then be weighed against each other to obtain a qualification (negligible, low,
high, or very high) of the probabilities of exposure (establishment and spread).

Reminder
We are referring to the weighing of risk factors against each other. The risk of exposure levels
defined in this way can be treated as exposure probabilities (AFSSA, 2008).

With a group of relevant experts, you must answer the following questions:

Under what conditions can one consider that an administrative division presents a very high
risk of exposure/establishment, and the spread of the pathogen there is very likely?

Under what conditions can one consider that an administrative division presents a high risk
of exposure/establishment, and the spread of the pathogen there is likely?

Under what conditions can one consider that an administrative division presents a low risk of
exposure/establishment, and the spread of the pathogen there is unlikely?

All administrative divisions that do not fulfil any of the above conditions present a negligible risk
of exposure; i.e. the establishment and spread of the pathogen via live animals or animal products
there is improbable.

NB As for the risk of introduction, you can also directly ask yourself about the risk factors:
• Does the risk factor α alone lead to a very high/high/low risk?
• If not, if it was associated with one or more other risk factors, could the risk become

very high/high/low?
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How to proceed?

To minimize the subjectivity of the qualifications in the (qualitative) analysis and to be as accurate
as possible, most of the steps should always be carried out with a group of relevant experts (by
expert-opinion). The characterization of risk levels (weighing of risk factors against each other) is
one such step.

Exercise 5.1 Again, at the end of the discussions with the group of experts, you should all
agree on how to complete the following text:

“The risk is very high if..., otherwise, the risk is high if..., otherwise, the risk is low if...,
otherwise, the risk is negligible.”

NB The ‘...’ can be filled in with several conditions separated by ‘OR,’ and the conditions can
be defined by a combination of conditions connected by ‘AND.’

�

Exercise 5.2 Based on the information in this text, complete the table below:

Risk level
Very high High Low

NB Negligible risk does not appear in the table because if the risk is not very high, high, or
low, it must be negligible. Therefore, there is no need to characterize this risk level if the
three higher risk levels are correctly defined.

�

Example

Suppose three risk factors have been selected: animal density (for cattle and small ruminants),
accessibility (corresponding to the inverse of travel time between two points), and the presence of
water points. Animal density and accessibility are quantitative risk factors, so they are categorized
in four classes: N (negligible), L (low), H (high) and VH (very high), and the presence of water
points is a qualitative factor that is categorized in two classes: P (presence) and A (absence).

The risk is very high if [the animal density is very high (regardless of other factors)] OR if [the
animal density is high AND the accessibility is very high] OR if [the animal density is high AND
the accessibility is high AND at least one water point is present]; otherwise the risk is high if [the
animal density is high] OR if [the accessibility is very high] OR if [the animal density is low AND
the accessibility is high AND at least one water point is present]; otherwise the risk is low if [the
animal density is low] OR if [the accessibility is high] OR if [the accessibility is low AND at least
one water point is present]; otherwise the risk is negligible. Please refer to the table below:
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The risk level is...
Very high, if High, if Low, if

Animal density (VH) Animal density(H) Animal density (L)

OR Animal density(H) AND
Accessibility (VH)

Accessibility (VH) Accessibility (H)

OR Animal density(H) AND
Accessibility (H) AND
Water point (P)

Animal density(L) AND
Accessibility (H) AND
Water point (P)

Animal density(L) AND
Water point (P)

5.4 Fourth step: Mapping the risk of exposure

Once your risk levels are characterized, you must import your data into GIS software and map the
risk of exposure of the disease on the territory of your choice.

As for the analysis of the risk of introduction, the task is to review the characteristics of each
administrative division (the different risk factor categories associated with it) to determine the
risk level to attribute to each division. Once you have defined a risk of exposure level for every
administrative division, you can produce a map by colouring the administrative divisions according
to their risk level. It is agreed to respect the following colours (table below):

Risk Colour Code (Hex and RVB)
Negligible Green � #13d604 (19,214,4)
Low Yellow � #ffe74d (255,231,77)
High Orange � #ff8c4a (255,140,74)
Very High Red � #fc3232 (252,50,50)

Example Using the previous example, we will color in red all of the administrative divisions
where the risk of exposure is very high, in orange the divisions where the risk is high, in yellow the
divisions where the risk is low, and finally in green the divisions where the risk is negligible.

Thus, all administrative divisions with a very high animal density must appear in red on the
map. The same holds for administrative divisions where animal density is high and associated
with a very high accessibility, and for administrative divisions where animal density is high and
associated with a high accessibility and the presence of at least one water point.

Following the same logic, among the remaining administrative divisions, those that appear in
orange are:
• the administrative divisions where animal density is high, but accessibility is not very high;
• the administrative divisions where accessibility is very high, but animal density is neither

high nor very high;
• the administrative divisions where animal density is low and associated with high accessibility

and the presence of at least one water point.
Lastly, among the remaining administrative divisions, those that appear in yellow are:
• the administrative divisions where animal density is low, but accessibility is neither very high

nor high and associated with the presence of a water point;
• the administrative divisions where accessibility is high, but animal density is neither very

high nor high and associated with the presence of a water point;
• the administrative divisions where accessibility is low and associated with the presence of at

least one water point.
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All of the other administrative divisions have a negligible risk of exposure because they do not
have a major risk factor; they therefore must appear in green on the map.

In the practical exercises (Chapter 9), we will see how to use free and easy-to-use tools to
produce risk maps from your data, once the four risk levels have been characterized with the expert
group.

Congratulations, if you have successfully completed all of these steps. You have produced a
map of the risk of exposure (establishment and spread) of an animal disease!

If that is not the case, go to Part II to carry out practically a qualitative and cartographic analysis of
the risk of exposure, using the example proposed in Practical Exercises, Chapter 9. This will allow

you train yourself using fictitious data and the proposed risk factors.
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The risk maps produced are relevant and effective decision-support tools. They can be used in
different activities, notably to steer health decisions aiming at optimizing surveillance and control
activities in animal health. We will now look at some examples of how they can be used.

6.1 Risk-based surveillance

As part of FMD surveillance, two types of surveillance can be set up:
Event-based surveillance via the obligation to report all suspicions of FMD on the territory. This

type of surveillance is generally applied in all OIE member countries because FMD is a
notifiable disease (OIE, 2007).

Programmed surveillance via serological or virological surveys, whether under the framework
of active searches for cases or to estimate the disease seroprevalence on a given territory. As
mentioned in Chapter 2.1 (page 11), programmed surveillance is generally expensive, but its
cost-benefit ratio can be optimized by allocating the resources available according to the risk;
this is known as risk-based surveillance.
As a reminder, the objective of risk-based surveillance is to maximize the probability of
detecting a potential introduction/spread of a pathogen on the territory while reducing costs.
The task is to prioritize surveillance activities based on the risk level.

Risk-based surveillance protocols are determined by six main criteria:
• Susceptible species (animals) (e.g. for FMD, animals of the order Artiodactyl, suborder

Ruminants, and family Suidae, as well as camelids of the species Camelus bactrianus);
• Areas at risk of introduction and risk of exposure (see risk maps);
• Gathering and trading points (markets, water points, pastures, veterinary inspection posts,

and border crossing points);
• Actors responsible for surveillance;
• Peak activity periods: trade, transhumance, or, vector season for a vector-borne disease;
• Estimated prevalence of the disease in the area (e.g. at the country level) or estimation of a

threshold prevalence.
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By using these criteria, it is possible to adapt/optimize surveillance activities from different angles
while remaining within the framework of the strategy adopted at the national level and taking into
account the monitoring activities already in place in the country.

With Spatial Qualitative Risk Analysis (SQRA), we can spatially discriminate areas that are at a
high and very high risk of both FMD virus introduction and exposure. We can optimize surveillance
strategies by looking at the distribution of the risk areas. The need to intensify surveillance efforts
in high and very high-risk areas is self-explanatory.

Based on the risk maps produced by SQRA, consider the possibility of concentrating
programmed surveillance efforts on high and very high-risk areas while maintaining
event-based surveillance and awareness-raising activities in low and negligible risk areas.

An example of a risk-based surveillance plan for FMD

A risk-based FMD surveillance plan could combine two types of surveillance applied differently
over the territory, depending on the estimated risk level.
Event-based surveillance over the entire country, to ensure early detection on livestock farms,

encouraging the declaration and testing of susceptible animals with clinical signs consistent
with the disease.

Programmed surveillance in areas at high or very high risk of introduction or exposure, in order
to:

1. Early detect subclinical infections and virus circulation among certain at-risk animal
populations;

2. Help demonstrate that an area (e.g. the entire country or a specific region) has a
disease-free status.

As part of the programmed surveillance in the areas at high and very high risk of introduction,
different surveillance activities can be organized and adapted to the risk.

An example of a risk-based surveillance activity: Risk-based sampling

Sampling procedures for FMD are developed in conformance with the OIE Manual of Diagnostic
Tests and Vaccines for Terrestrial Animals (OIE, 2019a). The OIE recommends using the ELISA
technique, which detects the antigens of the FMD virus and is used for serotyping.

The objective of risk-based sampling is to maximize the effectiveness of veterinary inspections
by adopting a strategy to prioritize activities according to risk. An activity based on the risk can be
optimized by using different criteria.

For effective sampling, you must carefully study and define at least four parameters:
Sampling period: This must be adjusted to the seasonal nature of the livestock production. A risk

analysis can thus highlight periods of risk, such as around religious festivals when animal
movements increase. The most effective sampling is conducted during periods of risk.

Type of sampling sites: Drawing from a risk assessment, the sampling plan must also take into
account the types of sites sampled (free-range farm, livestock market, slaughterhouse, etc.)
and the risk factors associated with each type (e.g. the presence of different species on the
same farm).

Number of sites sampled: This must be determined in a way that ensures the early detection of a
virus as soon as it is introduced in a territory. It is calculated according to the prevalence of
the disease in the country (the higher the prevalence, the higher the probability of detection,
the lower the minimum number of sites to be sampled). The number of sites sampled in an
area should be proportional to the probability of introduction and exposure of the area. In the
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case of an FMD-free country, sampling efforts must focus on areas where the probability of
introduction and exposure is high and very high.

Number of animals sampled per site: This must be determined in a way that ensures the detection
of at least one animal presenting a positive reaction in an infected population. It depends on
several parameters, including herd size and the prevalence rate in the population (Elnekave
et al., 2016).

NB In the case of FMD, high vaccination coverage seems to efficiently reduce the risk comparatively
to low vaccination coverage (Gonzales et al., 2014).
This type of information from ongoing research can also be taken into account when
determining a surveillance protocol.

For more information
Epitools, developed by the Australian Biosecurity Cooperative Research Centre for Emerging
Infectious Disease (AUSVET), offers a method to calculate the number of sites and the number of
animals per site that should be sampled for optimal sampling. This tool is available online free of
charge (The Australian Biosecurity Cooperative Research Centre for Emerging Infectious Disease,
2019).

Another approach providing similar results is proposed in the 4th edition of the book: Toma,
B. et al., 2018. Epidémiologie appliquée à la lutte collective contre les maladies animales
transmissibles majeures (Toma et al., 2018).

6.2 Risk-based control

The OIE recognizes four strategies for the control and eradication of FMD in susceptible animals
(Agence canadienne d’inspection des aliments, 2013; OIE, 2007). These strategies are:
• Slaughter of all clinically affected animals and of susceptible animals that have been in

contact with them–as in the United Kingdom in 2001;
• Slaughter of all clinically affected animals and of susceptible animals that have been in

contact with them and vaccination of at-risk animals, followed by slaughter of vaccinated
animals–as in Japan in 2010;
• Slaughter of all clinically affected animals and of susceptible animals that have been in contact

with them and vaccination of at-risk animals, without subsequent slaughter of vaccinated
animals-as in South Korea in 2010-2011;
• Emergency vaccination used without slaughter of infected animals or subsequent slaughter

of vaccinated animals-as in Ecuador in 2011, or in South Korea in 2010-2011.
The main control activities implemented in these strategies are stamping-out (slaughter) and

vaccination. However, there are many more, such as restricting the movement of animals and
animal products, and increasing biosecurity controls. With again the objective of optimizing the
effectiveness of control strategies despite limited resources, we will look at two examples of how to
adapt control activities through the use of risk maps produced by SQRA.

An example of a risk-based control activity: vaccination based on risk

Vaccination is one means to prevent and control the spread of a disease in a given territory.
Implemented against FMD, its objective is to obtain a specific protection of susceptible animals
against a homologous virus strain.

Generally implemented after a field assessment, vaccination can significantly reduce clinical
signs and virus excretion associated with an epizootic disease. Veterinary services often use

https://epitools.ausvet.com.au/
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Emergency vaccination: a controversial measure for government services and trading
partners

In the absence of quality diagnostic tests recognized by the OIE that can distinguish naturally
infected from vaccinated animals, vaccination significantly complicates the process of recovering
the FMD-free status after an outbreak and impacts the waiting period required to regain the
status. For instance, when a FMD case occurs in a FMD free country where vaccination is not
practiced, the recovery of the OIE “FMD-free status without vaccination”, without the slaughter
of vaccinated animals following emergency vaccination, can take place only after 6 months after
the disposal of the last animal infected or the last vaccination (OIE, 2019b), compared to three
months with the emergency vaccination followed by subsequent slaughter strategy.
At the level of international trade, many trading partners refuse to restore trade following the
implementation of a vaccination strategy without the subsequent slaughter of vaccinated animals
(Agence canadienne d’inspection des aliments, 2013).

Type Advantages Disadvantages

Health
Risk of infection in
susceptible animals reduced
in the event of an epizootic.

Protection conferred by
vaccination begins around
the 7th day, although a
decrease in the spread of the
virus can be observed from
the 4th day post-vaccination.

Replication of the virus
and its excretion in infected
animals limited, slowing the
speed of the spread of the
epizootic.
Number of clinical outbreaks
reduced and spread reduced.

Virus spread by vaccination
teams.

Socio-economic

Number of culled animals
reduced.

Virus spread by slaughter
teams.

Losses for farmers reduced. Costs of serological tests to
recover disease-free status
are high.

Media impact decreased. Significant trade restrictions.
Depending on the size of the
epizootic, fewer resources.

Depending on the size of
the epizootic, significant
resources.

vaccination when an FMD outbreak is detected in the territory or if infected neighbouring countries
represent an epidemiological threat (geographical proximity and trade links).

Regardless of the management measures undertaken, veterinary services should develop a
vaccination plan related to the national control strategy, relying on national and local experts and
using tools such as the risk maps produced by SQRA.

Two examples of risk-based vaccination plans

We shall look at two examples of vaccination plans that could be implemented in two different
contexts: i) the case of a disease-free country that implements a vaccination plan aiming to protect
its livestock from the possible introduction of the disease, and ii) the case of a country affected by
an epizootic that implements a vaccination plan to control the spread of the virus and eradicate the
disease.
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Disease-free country While applying biosecurity measures and controlling animal movements,
vaccination against FMD should increase resistance to virus infection, reduce viral shedding levels,
and prevent clinical signs if the virus is introduced. In a disease-free country, vaccination over
the entire country can be very expensive. One option to reduce vaccination-related costs would
be to create a vaccination buffer zone along the borders; another would be to conduct vaccination
campaigns in areas with a high and very high risk of the introduction of the disease (see risk maps
produced by SQRA).

Depending on the situation, expert advice is required to select the susceptible animals to
vaccinate, the suitable vaccines and determine the frequency of campaigns (annual or semi-annual
vaccination). The success of vaccination also requires setting up monitoring and evaluation, as well
as resources for smooth implementation. Nonetheless, we must keep in mind that this preventive
method does not stop the introduction or spread of a virus (AFSSA, 2009) and may even delay the
early detection of an FMDV incursion.

Country affected by an epizootic In the event of FMD outbreaks at the national level, vaccination
should be carried out in combination with other control measures, notably stamping out, biosecurity
control, active serosurveillance and awareness-raising. The implementation of these control
measures over the entire country can be very expensive. While implementing emergency vaccination
at the level of outbreaks and in the buffer zone around outbreaks, countries could increase
effectiveness and reduce associated costs by prioritizing areas with a high or very high risk of
exposure (see risk maps produced by SQRA).

We must keep in mind that the control of FMD by vaccination alone, without slaughtering
infected animals, will probably not be effective. The effectiveness of such a policy also depends on
the characteristics of the viral strain involved, the density of the farms and the number of animals,
the level of biosecurity and the collaboration between stakeholders (manufacturers and farmers), as
well as the logistic capacities of the veterinary services such as the availability of vaccines (vaccine
banks) and adequate administration (coverage of many farms in a short amount of time) following
stringent biosecurity measures. Furthermore, the movements of vaccination teams may represent a
significant risk of spreading the infection (AFSSA, 2009).

Emergency situation training
National measures in the event of FMD outbreaks are more effective when the actors involved
have been trained/informed in advance. Four points must be taken into consideration:
Establishment of a group of experts This involves maintaining a panel of national and

international experts in the event of outbreaks (at the national level or in the region)
to answer questions such as the possibility of protective emergency vaccination, zoning
and other measures adapted to combatting and controlling FMD;

Field alert drills This involves running field alert drills to maintain vigilance and awareness
among managers (veterinary services) and experts (laboratory) as well as field actors
(farmers, industry, police) regarding the possibility of an FMD outbreak;

Regional scientific and health exchanges related to FMD This involves setting up exchanges
with veterinary services in the region (and especially with countries where the disease
is present). This provides the opportunity to observe clinical conditions, face health and
economic situations different from those of the national territory while attempting, if
needed, to contribute their own level of expertise (organization of a laboratory, diagnosis
and vaccination);

Evaluation of the effectiveness of the vaccination This involves having the information which
makes it possible to monitor the effectiveness of the vaccination campaign. Such
information may include: the targeted population, rate of vaccination coverage, including
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serological follow-up of the immunity of the population, the authorizations and technical
specifications of the vaccines used and the vaccination schedule, in accordance with the
standards of the OIE Terrestrial Manual.

An example of a risk-based control activity: animal movement restrictions

Animal movements are one of the most important risk factors with regard to the spread of epizootics
(Dubé et al., 2009; Hässig et al., 2015). The control of animal mobility is therefore crucial to
control the spread of a disease and to eradicate it.

The implementation of surveys, control interventions, serological samples and analyses can,
once again, be very expensive. To reduce costs, you can use the risk maps produced by SQRA to
make proposals by focusing efforts and available resources on areas with high or very high risks of
viral spread.

International trade in live animals
Following the detection of an FMD case, the maps produced by SQRA concerning the FMD virus
can guide health authorities on where to focus control efforts. For example, imports of live animals
and animal products coming from a country with:
a negligible risk of release could be maintained without restrictions, with only controls of health

documents/certificates;
a low risk of release could be subject to the application of certain risk reduction measures (e.g. in

low risk areas, one could set up quarantines for imported animals);
a high risk of release may be subject to an in-depth assessment of risk reduction measures, their

effectiveness and feasibility (e.g. in high-risk areas, setting up quarantines of imported
animals and systematic serological analyses); systematic serological analyses);

a very high risk of release could be prohibited with a full embargo on animal imports.
Similarly, on the basis of risk maps and consultation with experts, national health authorities

could choose to intensify controls in areas of high and very high risk of introduction, such as border
areas or the focal points of international animal mobility networks highlighted by the mobility
analysis (SNA).

Animal mobility on the national territory
Once the virus has been introduced in the territory, restrictions must also be applied to animal
movements within the country. Like for international trade, the maps produced by SQRA for FMD
can guide health authorities in their allocations of resources and control efforts.

For example, animal movements originating from areas with:
a negligible risk of exposure could be maintained without additional restrictions although

continuing to observe basic regulations, such as verifying veterinary documents at sale/slaughter;
a low risk of exposure could be subject to prior risk reduction measures (e.g. verification of

compliance with health and biosecurity measures);
a high risk of exposure could be subject to a more in-depth assessment of risk reduction measures,

their effectiveness and feasibility (e.g. the movement of animals from farms in high-risk
areas to slaughterhouses could be controlled and monitored to prevent contact with other
susceptible animals);

a very high risk of exposure could be completely prohibited.

Now think about the monitoring and control systems set up in your country and propose
improvements based on risk maps produced with SQRA.

If you encounter difficulties in interpreting your risk maps or in developing recommendations, do
not hesitate to contact the team of expert trainers at CIRAD and EuFMD (team.aqcr@cirad.fr).

mailto:team.aqcr@cirad.fr
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Some concrete examples:
• In Burkina Faso, the vaccination campaigns under the Peste des petits ruminants eradication

program were stratified based on the risk maps produced by SQRA.
• In Senegal, SQRA was used to produce risk maps for Rift Valley fever, Ebola, and

Crimean Congo haemorrhagic fever.
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7. Getting started with QGIS

This course is an adaptation of bulletins published by the Caribbean Animal Health Network:
CaribVET.

7.1 Discovering QGIS

The course aims to train you in the basics of Geographic Information Systems (GIS) (see section
2.4 for details on GIS). We will explain the main ideas and terminology and provide a few examples.
Although there are a lot of complex algorithms behind GIS software, it is not necessary to study
applied mathematics before getting started. GIS is an applied science and the best way to train
is to practice, experiment, make mistakes and then start over again. Consequently, the practical
exercises are the most important part of the course.

7.1.1 What is QGIS?

QGIS is an official project of the Open Source Geospatial (OSGeo) foundation. Formerly known as
Quantum GIS, QGIS is a free, open-source GIS software program that enables you to visualize,
modify and analyse spatial data.

QGIS is a multiplatform software program that can be run on Windows, Mac OS X, Linux,
Unix and Android. It can support several vector, raster, and database formats and functionalities.

The software is under constant development and relies on a large community of volunteers
and organizations. This gives it stability, a functional field and the capacity to be upgraded that
is the equivalent – or even superior to – market-based solutions such as ArcGis, MapInfo and
GeoConcept.

Combining free access with performance, QGIS is a standard bearer in the world of GIS, which
is why we chose it to conduct the cartographic and qualitative risk analysis presented in this guide.

7.1.2 Installing QGIS

To start, you need a computer and an internet connection.
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~���1 Open your internet navigator and go to the page:
http://qgis.org/en/site/forusers/download.html~���2 Download the latest version of QGIS, e.g. “QGIS Standalone Installer Version 3.6 (32 bit)”.
Don’t worry if you have a 64-bit computer. This version will still work perfectly well.~���3 Once the file is downloaded, simply double click on it and follow the installation instructions.

NB Downloading the file (file size > 300 Megabytes) and installing the software can take
some time if your internet connection is slow (from 20 min to 1.5 hours). Be patient,
and take the opportunity to do something else and talk with your colleagues.

If needed, watch the video of the
QGIS installation procedure.

7.2 Basic use of QGIS

7.2.1 Creating your first project

This is easy: Open QGIS and on the task bar in the upper left corner, click on Project » New .
Afterwards, don’t forget to save your project before leaving.

7.2.2 Importing your first data

What are spatial data?

By definition, they include information about the physical placement and shape of geometric objects.
These objects can be the locations of points or more complex objects such as countries, roads and
lakes.

In GIS, data are represented as layers containing spatial objects. There are three classes of
spatial objects defining what is known as the layer geometry: (i) points, (ii) lines and (iii) polygons.
Points are often used to represent towns, addresses or field observations. Rivers and roads are
generally represented by lines. Lastly, administrative units (e.g. countries, townships) are good
examples of the use of polygons.

What formats can spatial data have?

In a GIS, you can import data in different forms:
• as a table (Excel, CSV, TXT,. . . );
• as a vector (SHP, DXF, . . . );
• as an image or raster (JPEG, TIFF, . . . ).
The most commonly used formats are vectors and rasters. While the tabular format only

manages points, the vector format manages points, lines and polygons. The spatial objects contained
in vectors and tables can be supplemented by non-spatial alphanumeric information (e.g. the name
of a town or the number of inhabitants). Raster data are stored as cells forming a grid. These data
are also supplemented by alphanumeric data such as the mean, the maximum and the minimum.

All non-spatial information of spatial objects, in other words, the alphanumeric data of vectors
and tables, are listed in what is called an attribute table.

http://qgis.org/en/site/forusers/download.html
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Where do spatial data come from?

Spatial data are obtained via remote sensing and mapping.
Considerable amounts of data are freely available online. Before conducting a field sampling,

first check whether the data you are looking for are already available online.

Here are a few sites where you can find quality data online:
DIVA-GIS Free spatial data covering the entire world, including administrative boundaries, roads,

population densities, etc.
http://www.diva-gis.org/

GADM maps and data Free spatial data illustrating the administrative boundaries of countries
around the world.
http://www.gadm.org/country

FAO GeoNetwork Free spatial data covering the entire world, with notably animal densities,
livestock systems, etc.
http://www.fao.org/geonetwork/srv/fr/main.home

Esri Open Data Free spatial data covering the entire world, with notably protected area zones,
transportation networks, etc.
https://hub.arcgis.com/pages/open-data

NASA Earth Observations (NEO) Free global climate and weather data. https://neo.sci.gsfc.
nasa.gov/

Some tips and tools for gathering spatial data in the field If you did not find the data you are
looking for online, you can still collect spatial data through surveys as long as you use a geolocation
device (for example, GPS, smartphone, tablet).

You have two options:
• Create your questionnaire in a text editor such as MS Word (an example of a questionnaire

created to collect data on animal mobility in Mauritania is presented in Annex 9.2.4) and
supplement the information by manually filling in the GPS coordinates of each data in the
form.
• Use a dedicated digital tool such as Kobotoolbox (you can follow CIRAD’s online training

course: HERE).

How are spatial data imported into QGIS?

To import spatial data into QGIS, you must choose the tool based on the format of your data.

Vector layer To add a vector layer, you have two options:
• Use the menu at the top of the screen

Layer » Add layer » Add vector layer...

• Click on the icon : on the left of the screen

Raster layer To add a raster layer, you have two options:
• Use the menu at the top of the screen

Layer » Add layer » Add raster layer...

• Click on the icon : on the left of the screen

http://www.diva-gis.org/
http://www.gadm.org/country
http://www.fao.org/geonetwork/srv/fr/main.home
https://hub.arcgis.com/pages/open-data
https://neo.sci.gsfc.nasa.gov/
https://neo.sci.gsfc.nasa.gov/
https://www.kobotoolbox.org/
https://elearning.cirad.fr/enrol/index.php?id=77
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Tabular layer To add a tabular layer, you have two options:
• Use the menu at the top of the screen

Layer » Add layer » Add delimited text layer...

• Click on the icon : on the left of the screen
In all cases, a window opens so you can select your file.

Exercise 7.1 Importing a vector layer
• Create a new project that you call Exercise 7.1
• Go to the GADM maps and data website and download the spatial data representing your

country’s administrative boundaries.
Note: adm0, adm1, adm2, etc. refer to different administrative division levels; you can try
several to choose the one that is best for you.

• Add the layer with the .shp extension to your QGIS project.
Question 1 What is the format of your layer (vector, tabular, raster)?
Question 2 What type of objects does your layer contain (points, lines, polygons, cells)?

�

Solutions: Watch the video on how to do
exercise 7.1 for Mali.

Exercise 7.2 Create and import a tabular layer
• Create a new project that you call Exercise 7.2
• Download the spatial data representing the administrative boundaries of Morocco (see

exercise 7.1).
• Add the layer representing the administrative boundaries of Morocco in your QGIS

project.
• Create an Excel table with three columns, following the example below, filling in the last

line using the site:
https://www.coordonnees-gps.fr/conversion-coordonnees-gps
Then save it in CSV format.

City Longitude Latitude
Rabat -6.8325500 34.0132500
Casablanca -7.6113800 33.5883100
Marrakech -7.9999400 31.6341600
Essaouira - - - - - -

• Add the tabular layer with the .csv extension representing the cities in your QGIS project.
Tip: Use the same coordinate reference system for all of the layers in your project

Question 1 How many layers does your project have?
Question 2 What type of objects do your layers contain (points, lines, polygons, cells)?

�

https://www.coordonnees-gps.fr/conversion-coordonnees-gps
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Solution: Watch the video on how to do
exercise 7.2 for Morocco.

Exercise 7.3 Importing a raster layer
• Create a new project that you call Exercise 7.3
• Go to the FAO GeoNetwork website
• Download the spatial data representing the global distribution of cattle (Cattle distribution

- Gridded Livestock of the World v 2.01).
• Add the layer with the .tif extension to your QGIS project.

Question 1 How many layers does your project have?
Question 2 What type of objects does your raster layer contain (points, lines,

�

Solution: Watch the video on how to do
exercise 7.3

7.2.3 Changing the order of layers

The layers are superimposed in the order shown in the legend on the left. You can change the order
of the layers by clicking on the name of a layer in the legend on the left and dragging it.

7.2.4 Hiding a layer

To make a layer invisible, click on the box in front of the name of the layer in the legend. Once the
box is no longer ticked, the layer is no longer visible on the map.

7.2.5 Removing a layer

You can remove a map layer by right clicking on the name of the layer in the legend and selecting

Remove .

7.2.6 Zooming in and out

With the menu View » Zoom + / Zoom - , you can zoom in on a given area by clicking on the
screen or by drawing a rectangle on the map. You can also directly use the shortcut buttons on the

top bar: et .

http://www.fao.org/geonetwork/srv/en/main.home
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7.2.7 Retrieving information about the different objects in the map

Non-spatial information about spatial objects (vector layers and tabular layers) are contained in
what is called the Attribute Table. Each row represents a feature/spatial object (polygon, point, line
according to the geometry of your data) with its attributes distributed in several columns.

To navigate in this table, right-click on the layer of interest and select Open Attribute Table

( ).
To obtain information about a specific object, you have two options:
• If you select a row in the attribute table, the corresponding spatial object will appear in yellow

on the map. Conversely, by using the tool View » Select » Select features by area or by

simply clicking ( ), you can select an object on the map by clicking on it which will
then appear in yellow on the map, and the corresponding row will be selected in the attribute
table.

• You can use View » Identify features ( ) and click on the part of the map that interests
you.

The attribute table makes it possible to visualize data, as well as to sort and edit data.

7.2.8 Changing data in the attribute table

To change data in an attribute table, click on the layer of your choice and open the attribute table

( ). Switch to Toggle edit mode ( ). You can now edit the table in the same way as in an Excel
table:
• Double click on the cell to be edited
• Use the icons: to add (yellow) or remove (red) columns

• Save your changes .

Click again on to close the editing session. Note that while the attribute table is being
edited, the contours of the map are covered with red crosses (even if you close the attribute table).

For more information go to the online QGIS guide on how to work with attribute tables

Exercise 7.4 Finding information in the attribute table
• Create a new project that you call Exercise 7.4.
• Go to the Diva-GIS website to download the shapefile file (vector) representing the

administrative divisions of Guinea.
• Add the GIN_adm3.shp layer to your project.
• Select the 5 sub-prefectures of Conakry prefecture in Conakry region and observe their

location on the map.

• Use the tool to select on the map the coastal sub-prefectures and find in the attribute
table what department they belong to.

• Add a new column; name it “Status”; set the Type as Text (string) and set its Length

at 50. Then click OK .. Enter “coastal” for coastal municipalities and “interior” for
other municipalities.

Question 1 Where are the five sub-prefectures of the Conakry prefecture located?
Question 2 How many sub-prefectures does Guinea have? How many of these are coastal

https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/attribute_table.html?highlight=attribute%20table
http://www.diva-gis.org/
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sub-prefectures?
�

Solution: Watch the video on how to do
exercise 7.4

7.2.9 Changing colours

To change the colours of a layer, you need to access its properties. By double clicking on a layer,

the Properties window opens. You also can open the window by right clicking on the layer and

selecting Properties .
The Layer Properties window presents different tabs listed on the left menu. In the second tab

( Style ), you can change your map’s colours and symbols.
To change the colour of a polygon layer, there are different options that you can define at the

top of the window. The three most commonly used are:
Single symbol Uniformly change the entire layer.
Categorized Colour according to a qualitative attribute (country, presence/absence of veterinary

post in a municipality, etc.). Select in column the attribute of your choice, then select one

of the colours proposed in the Colour palette , you can then change the colours individually
for each category by clicking on the colour square in front of the name of the category. Click

on Classify to attribute colours to the categories of your attribute.
Graduated Colour according to a quantitative attribute. The principle is the same as for categories,

however, you create classes regrouping objects by value intervals. You can choose the color,
the number of classes and the classification mode (interval, quartile, etc.).

Whatever you choose, you can modify:

• The polygon’s Fill Colour. For the polygon to be transparent, you either can select No Fill
in the Fill menu (be careful to click on the arrow and not the color rectangle for this option),

or Transparent fill in Fill Style. - The Colour of the outer Border of the polygon. - The
Width of the outer Border of the polygon.

If you only want to highlight one or two categories, remove all other countries from the list

(click on the country names and then on ). Notice that at the end of the list, there is a coloured
square with no Value or Legend. This line refers to all of theother values’ which are not in the list.

Click on OK to see the result on the map.

Take some time to try different options. When you use the Categorized option, you cannot

change the entries in the Value column, but you can edit the legend (double-click on the name
you want to change).

7.2.10 Adding labels

The 3rd tab in the Layer Properties window is “Labels”. You can use it to add labels to the map.
All values in the attribute table can be displayed. By default, they will appear in the centre of the
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corresponding polygon.

To add labels, select Show labels for this layer instead of No labels . Then, in the

Label with drop-down menu, select the attribute you want to appear. Click on OK .

Exercise 7.5 Changing colours
• Create a new project that you call Exercise 7.5.
• Go to Gadm.org to download the administrative divisions of Mauritania.
• Add the MRT_adm2.shp layer to your project.
• Colour the polygons in orange with a black border of 0.5 mm and click on Apply to see

the result.
• Colour each administrative region ( NAME_1 ) with a different colour.

• Add the names of the departments ( NAME_2 ) and have fun trying the different options.
�

Solution: Watch the video on how to do
exercise 7.5

7.3 Advanced use of QGIS

We recommend that you follow free MOOC (online training) offered by Yonsei University:
• Spatial Data Science and Applications (Coursera)
For French speakers, we recommend the two free MOOCs (online training) offered by the

École Polytechnique Fédérale de Lausanne:
• Introduction aux Systèmes d’Information Géographique - Partie 1 (Coursera)
• Introduction aux Systèmes d’Information Géographique - Partie two (Coursera)

https://www.mooc-list.com/course/spatial-data-science-and-applications-coursera
https://www.mooc-list.com/course/introduction-aux-systemes-dinformation-geographique-partie-1-coursera
https://www.mooc-list.com/course/introduction-aux-systemes-dinformation-geographique-partie-2-coursera


8. Getting started with R

This course aims to give you tips for training in the statistical software R.

8.1 Discovering R

8.1.1 What is R?

R is a free, open source software and statistical language that enables you to analyse, modify and
visualize data. It is very powerful and provides the standard procedures for the statistical analysis
of data.

R is a multiplatform software that can be run on Windows, Mac OS X, and Linux. It provides
a wide variety of graphical statistics and techniques (linear and nonlinear modelling, classical
statistics tests, classification, clustering ...) to which additional elements can be added. Lastly, one
of R’s strengths lies in its ability to facilitate the production of graphics by including mathematical
symbols and formulas when needed.

This software is under constant development and relies on a large community of volunteers and
organizations. This gives it stability, a functional field, and the capacity to be upgraded that is the
equivalent – or even superior to – market-based solutions such as XLSTAT, Minitab and Stata.

Combining free access with performance, R has become a benchmark in the world of statistics
in both academia and business.

8.1.2 Installing R and RStudio

To start, you need a computer and an internet connection.~���1 Open your internet navigator and go to the page:
https://cran.r-project.org/~���2 Download the latest version of R adapted to your operating system (Linux, Mac Os or
Windows), e.g. click on “Download R for ...” then follow the instructions to download the
installation file.

https://cran.r-project.org/
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~���3 Once the file is downloaded, simply double click on it and follow the installation wizard.

NB Downloading the file and installing the software can take some time if your internet
connection is slow. Be patient, and take the opportunity to do something else and talk
with your colleagues.

To facilitate your use of the R software, we recommend that you install the RStudio graphic
interface.~���1 Open your internet navigator and go to the page:

https://www.rstudio.com/products/rstudio/download/#download~���2 Download the latest version of RStudio adapted to your operating system (Linux, Mac Os or
Windows), e.g. Scroll down the page to reach the section with the “Installers”, click on the
installer “RStudio ...” appropriate for your computer.~���3 Once the file is downloaded, simply double click on it and follow the installation wizard.

If needed, watch the video of the R and
RStudio set up procedure.

8.2 Training yourself in the basic use of R

Although it is not essential that you know how to use R in detail, we recommend that you follow
free MOOCs (online training) such as the ones offered on DataCamp website (Introduction to R)

For French speakers, we recommend the free MOOC offered by the Université Paris-Sud:
• Introduction à la statistique avec R

https://www.rstudio.com/products/rstudio/download/#download
https://www.datacamp.com/courses/free-introduction-to-r
https://www.fun-mooc.fr/courses/course-v1:UPSUD+42001+session09/about


9. Application of the method: case of Tunisia

In this section, we describe the steps of how to conduct a Spatial Qualitative Risk Analysis (SQRA)
for foot-and-mouth disease (FMD) in Tunisia. We shall use fictitious data that were created for this
exercise.

Prerequisites

Knowledge in methodology and epidemiology

• Qualitative risk analysis (see Chapter 2.2)
• Social network analysis (SNA, see Chapter 2.3)
• Risk mapping
• Risk-based surveillance

Technical expertise

• Basics in Excel or OpenOffice Calc
• Basics in R
• Advance GIS skills, notably with QGIS

Software required

• QGIS
• R
• Excel or OpenOffice Calc
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9.1 Risk of introduction

A video tutorial and a slide presentation describing
in detail the steps of the analysis are available.

Risk of Introduction Application

Objective In this first step, we are seeking to estimate and map the risk of introduction of the
FMD virus in Tunisia.

9.1.1 First step: What are the risk factors for the introduction of the disease in your
country?

Before you do anything else, list the risk factors for the introduction of the FMD virus in Tunisia.

> What is likely to lead to or facilitate
the introduction of the FMD virus in Tunisia? >

Risk factors likely to lead to or facilitate the introduction of the FMD virus in Tunisia

We propose to work on certain risk factors that were defined and validated by experts when the
method was used for FMD in Tunisia. However, it is important to note that the factors proposed
here do not constitute an exhaustive list; they can be different depending on the territory and the
disease studied. If you are interested in another case study, you will need to define the risk factors
that you think are important to take into account by considering the characteristics of the disease
and the specific features of the national context (sector, actors, neighbouring countries, etc.) that
you want to study.

As we already described in section I, the risk of introduction depends on the country of
origin and the importation routes. Animal movements originating from an FMD-free country will
present less risk than animal movements originating from a country where the disease is endemic.
Likewise, animal movements originating from a country that has established strict surveillance and
control measures will pose fewer risks than animal movements originating from a country where
surveillance and control measures are limited.

The experts selected the following risk factors for FMD in Tunisia:
• the pathways of introduction (legal/controlled or illegal/uncontrolled),
• the epidemiological status of the countries from which Tunisia imports live animals (exporting

countries);
• the surveillance and control systems implemented in these exporting countries;
• the in-degree estimated by analysing the international animal mobility network. This is a

parameter from network analysis that makes it possible to highlight the main destinations
of movements/flows. In our case, as we are interested in an international animal mobility
network. This parameter will highlight the locations that receive the most animals coming
from outside the country, and
• the accessibility, which corresponds to the time needed to travel from one place to another. It

is considered here that the probability of importing animals from abroad is higher in the most
accessible areas, thus increasing the risk of introduction of the virus via an infected animal.
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Exercise 9.1
• Make an inventory of the risk factors of the introduction of the FMD virus in your country.

Draw inspiration from the bibliography and bring together national and sub-regional
experts (sector, context, etc. experts) for discussions.

• With the entire group of experts, make a list of all risk factors, rank them in order of
importance, and then select the principal ones, trying to limit yourselves to 5 risk factors.

NB You can draw inspiration from the list (non-exhaustive) presented in Annex page 121.

�

Define your work scale In the case of Tunisia, we have data at the delegation level (ADMIN 2),
so this is the scale on which we will work.

Exercise 9.2 Define the finest scale that you can use for your territory. If you do not have a
vector file (with a .shp extension) with the administrative divisions of your country, go to the
DIVA-GIS website and see what data are freely available.

NB On DIVA-GIS, you can download a zip file containing different division levels of your
territory. These divisions can be recognized by their names: adm0, adm1, adm2, etc. The
higher the number, the finer the division, and therefore the smaller are the administrative
divisions described.

�

Identify, retrieve and prepare data Now that we have selected the priority risk factors to work
on, we need to collect, “clean up", validate, and format the data.

To estimate the risk of introduction related to the pathways of introduction, epidemiological
status and surveillance and control systems of exporting countries (countries that export live animals
to Tunisia), we will use a cross-tabulation to qualify the risk of release of a given pathogen by a
given country. By using this file, we will:
• Verify the risk of release of Tunisia (see page 56).
• List cross border trade exchanges by differentiating between legal trade subject to surveillance

and control measures (see page 58) and illegal trade with a higher risk of introducing the
virus (see page 59).
• Define the risk of release of countries exporting live animals susceptible to FMD to Tunisia.
Then,
∗ We will locate and list the legal/controlled and illegal/uncontrolled border crossing points.
∗ We will see how to analyse animal mobility by carrying out a social network analysis (SNA).

This type of analysis will enable us to obtain synthetic parameters such as the in-degree.
∗ Lastly, we will see how and why accessibility is taken into account in the risk analysis.

Start of the application

Risks of release of exporting countries

Download the latest version of the risk of introduction estimation table: Release_Proba-EN.xls .
Open the file in Excel or in another spreadsheet such as OpenOffice Calc.

The file has four sheets:

1. Help: This sheet briefly presents the rest of the file and gives the instructions needed to use it
correctly.

https://www.diva-gis.org/
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2. Surveillance & control: This sheet presents a summary of the estimated risks of introduction
for the country you are studying, as well as information on the FMD surveillance and control
systems actually implemented in the field in different countries.

3. Animal mobility: This sheet presents the list of international commercial exchanges and
movements of live animals with the potential to carry the FMD virus from one country to
another (cattle, pigs, goats, and sheep). When you are working on a given country, the
countries with which it engages in international trade will appear in the last 5 columns.

4. Borders: This sheet lists the countries bordering each country. The countries sharing a
physical border with the country that you are working on will appear in the green section.

The surveillance and control systems concretely implemented in the field~���1 Go to the Surveillance & control sheet

This table enables you to estimate the risk of release of the FMD virus for each country in the
first column. This risk of release is estimated based on the surveillance and control measures
actually implemented on the territory. Experts have defined nine priority measures for FMD
that, if they are not implemented in the country, constitute a risk factor for the release of
FMD.

NB For each country: If a measure is implemented, the associated risk will be zero (0).
However, if the measure is not implemented in the country, the risk of FMD in the
country increases (>0). The sum of all of these risks gives a score out of 8. The score
calculated for each country qualitatively reflects the probability of the release of FMD
through infected animals.

The objective being to define the risk of the virus being introduced from one country to
another, three other priority risk factors were defined: importation routes (legal and illegal)
and the epidemiological status of the country of origin. These 12 priority risk factors (see
the 12 columns in the table) were weighted according to their importance in the management
of the risk. The weighing coefficients are indicated in red in column headings and their
relative importance in the overall risk of FMD introduction is graphically displayed on the
left of the sheet.~���2 Select Tunisia in the column COUNTRY of the main table. To do so,

(a) Click on the arrow in the header cell

(b) Deselect all countries by clicking (select all) and then,

(c) Click on the cell in front of “Tunisia” and click OK .

You have just applied a filter to only visualize the characteristics of Tunisia. Only the row
concerning Tunisia should now appear in the table.
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~���3 In the columns, “Surveillance systems in place in the countries” and “Control systems in
place in the countries”, let us check the scores and change them if necessary. For each column,
if the measure is actually implemented in Tunisia, the score is 0. If it is not implemented in
the field, you must apply the coefficient indicated in red in the header of the column.

NB For each risk factor: A more precise description of each risk factor is available by
clicking on the header of the column.

~���4 Redisplay all countries in the COUNTRY column by clicking on the arrow in the cell and

checking (select all) before clicking OK . All of the countries in our database should
now appear in the table.

Exercise 9.3 Do this step for your country.

NB If you notice an error or missing information, make the necessary modification in the
file and, if you wish, send an e-mail to inform the team of expert trainers of CIRAD
and EuFMD (team.aqcr@cirad.fr). The online file will be updated and your information
integrated.
With a view to collaboration, it is essential to update the data of your country regularly.
You need to know about the surveillance activities implemented in neighbouring countries
and exporting countries.

�

We are now ready to start the SQRA!~���5 Select Tunisia at the top left in the green cell using the drop-down menu.

The table must be filled in based on the international trade exchanges and national borders

of Tunisia. The data used for this table are available in the sheets Animal Mobility and

Borders . The next step in the work will be to check / validate these expert-opinion based
data, updating them if necessary.

mailto:team.aqcr@cirad.fr
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The importation routes of live animals likely to introduce FMD in Tunisia.~���1 Go to the Animal Mobility sheet. The name of Tunisia should automatically appear in the
blue cell at the top of the page. The last five columns display the names of countries known
to be exporting at-risk animals or products to Tunisia.

~���2 Select ‘Tunisia’ in the column Destination . Only trade movements towards Tunisia
should now be displayed in the table.~���3 This is the moment to verify and validate (add or remove) the trade exchanges/movements
according to knowledge based on expert opinion.
For the purposes of the exercise, we assume that you gathered a group of experts to check
and validate the list of exchanges. A working session with the experts made it possible to
identify three errors in the file’s list:
• Small ruminants are unofficially imported by road from Mali to Tunisia.
• No cattle are imported by road into Tunisia from Peru.
• In addition to cattle and small ruminants, camelids are also imported unofficially by

road from Libya.
The list in the spreadsheet therefore must be modified.
I Add a flow We will add an unofficial flow of small ruminants imported by road from

Mali to Tunisia.
Select the bottom row in the table by clicking on the number at the start of the row.

Right-click on this row and select Insert row . Place the cursor on the empty row that
just appeared and fill in the characteristics of the animal flows by completing the first 6
columns.

NB For the columns: Mode , Type , Origin , Destination , it is important to

use the drop-down menus so that the last columns and the Surveillance & control

sheet are automatically updated.

I Remove a flow We are going to remove the row corresponding to the importation of
cattle by road from Peru.
Right-click on the row that you wish to remove, then click on:

Delete » Table rows or Entire row of the sheet

I Modify a flow We are going to modify the contents of the unofficial imports by road
that take place from Libya towards Tunisia to add the camelids.
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Click on the cell that you wish to modify, then modify the contents by using the
drop-down menu when it is available.

NB Remember to enter you name in the column ‘Source’ when you modify or add
information.~���4 Once you have validated the information concerning Tunisia (Note: validation is normally

made as a group of experts), you must redisplay all of the countries in the column Destination .

To do so, click on the header arrow and check the box (Select all) .

Exercise 9.4 Gather your country’s experts and carry out this step together for your country.

NB It is important to notify the team of expert trainers at CIRAD and EuFMD(team.aqcr@cirad.fr)
about any modifications so that collaborative documents can be updated and the database
can evolve.

�

The countries bordering Tunisia~���1 Go to the sheet Borders . The name of Tunisia should appear in the blue cell at the top of
the page. The names of all of the countries sharing a border with Tunisia should appear in
the green cells.

~���2 Verify the data and correct them if required.~���3 Return to the Surveillance & control sheet. If you have made changes in the

Animal mobility and Borders sheets, the information in this table will have been
automatically updated. Save the file, indicating in the title the date it was updated; we
will use it in the rest of the SQRA.

mailto:team.aqcr@cirad.fr
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Exercise 9.5 Do this step for your country.
As the database is under construction, it is possible that the border countries have not yet

been filled in for your country or that there are a few errors. If that is the case:

• Select your country in the column headed COUNTRIES (deselect all then check the
box in front of the name of your country).

• Fill in the empty boxes or modify the boxes that have errors by using the drop-down
menus.

• Redisplay all of the countries in the column COUNTRIES .

NB It is important to notify the team of expert trainers at CIRAD and EuFMD (team.aqcr@cirad.fr)
about any modifications so that collaborative documents can be updated and the database
can reflect what is actually happening in the field.

�

If you have conducted the previous steps without encountering any problems, you have
filled in all of the importation data needed for the study of the importation routes.

Legal/controlled and illegal/uncontrolled border crossing points of animals and products at
risk.

In this section, we are working on the virus introduction stage; we therefore are seeking where the
virus would be most likely to enter the territory.

To do so, you must identify all of the known entry points into Tunisia:
• commercial airports
• commercial ports
• border inspection posts (BIP)
• illegal land border crossing points
• illegal maritime border crossing points
• etc.

For this exercise, we will assume that a field survey was conducted, and it has enabled us to fill in
the table BORDER_CROSSING_POINTS.csv; download this file so that you can complete the rest
of the exercise.

NB Note that the information contained in this file is fictitious and created for the exercise.

mailto:team.aqcr@cirad.fr
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Exercise 9.6 Do this step for your country.
If required, organize a survey to complete an equivalent table to the one on Tunisia with the

data concerning your country.

1. Create a table (Microsoft Excel or OpenOffice Calc).

2. Create 5 columns that you name:
NAME Name of border crossing point (optional)
TYPE Type of point (port, airport, BIP, etc.)
MODE Is it an official / controlled / legal point of entry (C) or a non-official / uncontrolled

/ illegal point of entry (NC)?
LONGITUDE_X in decimal degrees (i.e. Airport of Tunis: 10.219074500000033)
LATITUDE_Y in decimal degrees (i.e. Airport of Tunis: 36.8458578)

3. Fill in the columns

NB If needed, you can use this tool for the GPS coordinates:
https://www.gps-coordinates.net/gps-coordinates-converter)

4. Save in CSV format

�

In-degree

Now that we have the list of border crossing points into the territory, we will analyse the cross-border
movements/flows of live animals to highlight the final destination of the live animals that are
introduced. It is at this destination that the virus is most likely to enter into contact with the local
population of susceptible animals and cause an epizootic.

We need to identify the different flows of live animals susceptible to the disease that originate
from abroad and move towards Tunisia. For the purpose of this exercise, we will assume that a
survey was conducted that enabled us to fill in the file ANIMAL_MOBILITY.csv that contains
fictitious flows that we created for the exercise. Download this file to complete the remainder of the
exercise.

For the risk of introduction, we will only use the international flows. The national flows will
be analysed as part of the SQRA for the risk of exposure to FMD in Tunisia (Chapter 9.2). You
will notice that we have identified the international flows and the national flows in the same file to
prepare for the risk of exposure analysis.

Exercise 9.7 Do this step for your country.
If required, organize a survey to complete an equivalent table to the one on Tunisia with the

data concerning your country.

1. Create a new table in Microsoft Excel or OpenOffice Calc.

https://www.gps-coordinates.net/gps-coordinates-converter
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2. Create 9 columns that you name:
ORIGIN_NAME
ORIGIN_COUNTRY
ORIGIN_LONGITUDE_X
ORIGIN_LATITUDE_Y
DESTINATION_NAME
DESTINATION_COUNTRY
DESTINATION_LONGITUDE_X
DESTINATION_LATITUDE_Y
HEADCOUNT

NB Write the names in upper case without accents and take care to use consistent
spelling. Write the longitudes and latitudes in decimal degrees. You can do the
analysis without the headcount of the animals traded, but the analysis will be more
precise if you have this data.

3. Fill in the columns with your data.

NB Note that the flows that you indicate here must correspond to information that

you have put in the Animal mobility sheet in the estimation table of the risk

of release by exporting country. If this is not the case, it means that you need to
correct one of the two files.

4. Save in CSV format.

�

Flow analysis–network analysis

The entire set of movements forms a network. Using methods from social network analysis
(SNA), we will discriminate administrative divisions according to their role/importance in the
animal mobility network. Network analysis enables us to analyse and summarize these flows in the
form of various parameters reflecting the structure of movements within a country and between
countries.

We are working here on the risk of introduction of a virus, so we will only focus on the
international network. The analysis of the international network will enable us to highlight the
areas receiving the most animals/products and the areas where introduction is most likely.

For Tunisia, the experts chose to only consider one parameter, the in-degree. The greater the
flow of animals towards a location, the greater will be the in-degree of that location. We therefore
will calculate the in-degree for each location in our international animal mobility network.~���1 Download the latest version of the network analysis R script: SNA-EN.R .~���2 Open the file in R or RStudio – the illustrations in this tutorial use the RStudio interface (if

you need help to install and launch R or RStudio, go to Chapter 8).~���3 Scroll down the script to reach the section:

#######################################

## Define the location of your file ##

## and the name of your country ##

#######################################

~���4 Specify here the path to the folder where you want to save the results and check that the
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country name written in uppercase in quotation marks is that of Tunisia. Note, the ‘\’ in
Windows must be replaced by ‘/’ or ‘\\’ in the path of your folder and the name of the country
must be spelled as in the file ANIMAL_MOBILITY.csv.
Example:

setwd("C:/SQRA/Data/SNA")

my_country <- "TUNISIA"

~���5 Run the script by clicking Ctrl + A to select the entire script, then Ctrl + Enter to start
the script.~���6 A window will open to let you select the file with the animal movements describing the
mobility network. If the window does not appear, verify that it did not open behind RStudio.~���7 Once you have selected your data file “ANIMAL_MOBILITY”, click on Open .~���8 Graphs appear in the lower right-hand section. Once the scan is completed, you can look at
all of them by using the arrows at the top left of the graph.~���9 At the end of the scan, four text files (.csv) will automatically be saved in the folder that you
specified in the beginning. The file that interests you is called sna_Intro_Date.csv; the word
‘date’ will be replaced by the date of the day you conduct the analysis.

Exercise 9.8 Conduct the network analysis for your country.

NB Remember to replace the name of the country by that of your country, writing it exactly
as you did in the ANIMAL_MOBILITY.csv file with your country’s data.

�

Accessibility

The more a location is accessible, the higher the probability that the virus will be introduced there.
The Tunisian experts also have chosen to consider accessibility (travel time in minutes to go from
one point to another) as a risk factor for introduction.

Models estimating spatial variations in accessibility have been developed and many data are
freely available (Weiss et al., 2018).
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~���1 Download the global map of accessibility on http://forobs.jrc.ec.europa.eu/products/gam/
download.php. Please note that these datasets are subject to updates. Pelase check for
updates.

9.1.2 Second step: Categorize the risk factors

Risks of release of exporting countries~���1 Return to the risk of introduction estimation table: Release_Proba-EN.xls .

~���2 Go to the Surveillance & control sheet and verify that Tunisia is still selected in the green
cell on the top left.
We will now focus on the second part of the table.

(a) Move over to the right of the main table.

(b) To have better visibility of the data taken into account in the calculations, click on the

arrow in the header of the column Score , and

(c) Uncheck the box next to (Blank) .

http://forobs.jrc.ec.europa.eu/products/gam/download.php
http://forobs.jrc.ec.europa.eu/products/gam/download.php
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Only the countries posing a risk of introduction in Tunisia are displayed. These are the
countries likely to export FMD-infected animals to Tunisia. The bordering countries will
also be displayed because all borders are considered to be potentially porous and therefore
present a risk of virus introduction.~���3 Return now to the left of the table and check the information filled in for the epidemiological
status and surveillance and control systems of the countries at risk. For the purpose of this
exercise, we assume that you have gathered a group of experts to assess the consistency and
reliability of this information and that the data have been validated by all of the experts in the
group. In reality, if you had modified information, it would have been necessary to contact
the local authorities and/or the team of expert trainers at CIRAD so that the data would be
updated.

NB If you had noted errors, it would have been necessary to contact the local authorities
and/or the team of expert trainers at CIRAD and EuFMD so that the data would be
updated (team.aqcr@cirad.fr).~���4 Description of the five last columns in the table:

• SCORE: The first column gives the overall risk of introduction from a given country.
This risk is defined as a score out of 12 rounded to the unit (reminder for rounding to the
unit: If the number after the decimal point is less than 5, round down to the next integer. If
the number after the decimal point is greater than or equal to 5, round up to the next integer.
Example: A score of 3.2/12 is rounded down to 3/12 and a score of 6.5/12 is rounded up to
7/12). This score takes into account the importation routes used (knowing that any border is
considered an uncontrolled importation route), the epidemiological status of the country and
the surveillance and control systems implemented in the country of origin.

NB Once each sheet has been verified, you can consider that the scores (/12) for the risk of
introduction of FMD summarized in “Surveillance and control of data” are up to date.

• Risk level: The global score (/12) can be requalified as the level of the risk of release
of the virus. We consider four levels of risk. The risk associated with a score of between 0
and 3 is negligible and illustrated by the colour green. That associated with a score between
4 and 6 is low and is illustrated by the colour yellow. A score between 7 and 9 indicates a
high level of risk and is in orange, and a score between 10 and 12 reflects a very high level of
risk and is illustrated in red. A reminder of these values and colours is in the box on the top
left of the page.

The global score combines the risks of legal trade (controlled) and illegal flows (undeclared
and/or uncontrolled). Therefore, for countries that export animals through controlled AND
uncontrolled routes, there is a risk related to animal mobility of 4/4 (+1 [legal], +3 [illegal]).
One can also discriminate the risk by the introduction pathway.
• Legal: Here, the legal trade score is displayed, without taking into account possible

undeclared animal flows (1/4). This is the risk related to controlled imports.
• Illegal: Here, the illegal trade score is displayed, without taking into account the risk

related to legal trade (3/4). This is the risk related to uncontrolled imports.
• Border: Here, the illegal trade score is displayed, without taking into account the risk

related to legal trade when there are land borders shared with a country (3/4).

mailto:team.aqcr@cirad.fr
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~���5 In the box SUMMARY OF SCORES FOR YOUR COUNTRY in the upper left, you will
find a summary of the risks of introduction for the country studied (Tunisia in our case). In
qualitative risk analyses, by principle the risk is always increased (see Chapter2.2 page 12),
we will therefore retain the maximum estimated risk for each importation route. In other
words, we assume the most dangerous scenario to better prepare ourselves.

In the case of Tunisia, we have a very high global risk of introduction, a high risk related to
legal/controlled imports and a very high risk related to illegal/uncontrolled imports.~���6 Save your file. These levels of risk of emission will be used in step three to characterize the
levels of the risk of introduction.

Exercise 9.9 Do this step for your country. You should be able to answer the following
questions.

Question 1 How is the global risk of introduction of FMD into your country calculated?
Question 2 What is the global risk of introduction of FMD into your country?
Question 3 Which exporting countries pose the greatest risk for your country for each importation
route?

Question 4 What are the levels of risk associated with i) controlled imports, and ii) uncontrolled
imports in your country?

�

Legal/controlled and illegal/uncontrolled border crossing points of animals and products at
risk.

Border crossing points make it possible to assign the levels of risk calculated above to different
administrative divisions. There will be three categories:
• Absence of a border crossing point;
• Presence of at least one Illegal/Uncontrolled border crossing point;
• Presence of at least one Legal/Controlled border crossing point in the absence of an

Illegal/Uncontrolled border crossing point.

NB Uncontrolled border crossing points pose a much higher risk than controlled border crossing
points, which is why their presence presents a very high risk whether or not there is a
controlled border crossing point.

In-degree

For quantitative risk factors such as the in-degree (a quantifiable numerical value is associated with
each location in the animal mobility network), risk categories are generally defined using quantiles.

When you did the SNA in section 9.1.1, four CSV files were created:
sna_Intro Contains the mobility parameters for all locations in your international animal mobility

network.
qtl_Intro Contains the quantiles of the parameters calculated for your international network.
sna_Expo Contains the mobility parameters for all of the locations in your national mobility

network (this will not be used for the analysis of the risk of introduction).
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qtl_Expo Contains the quantiles of the parameters calculated for your national network (this will
not be used for the analysis of the risk of introduction).

In the file qtl_Intro, you will find an initial approximation of quantiles calculated for the
in-degree. These quantiles could be the limits of your four categories. However, as we are working
on the scale of the delegation (administrative division adm2), we must calculate the quantiles among
a set of data containing an in-degree per delegation. We will therefore do this step using QGIS. For
this case study, we have used the version 2.18.25 of QGIS.

~���1 Download the shapefile representing the administrative divisions ADMIN 2 of Tunisia (for
example, on the DIVA-GIS website).~���2 Open QGIS (if you need help to install or use QGIS, go to Chapter 7, page 43).

NB All explanations and screen shots are based on the use of version 2.18.25 of QGIS.

~���3 Using the function Add vector layer (see Chapter 7.2.2, page 45) import into QGIS
the borders of Tunisia with the adm2 division level (the finest division available online) which
we will use for the analysis.

NB Reminder: The smaller the administrative division, the more precise the analysis.

~���4 Import the SNA data file (sna_Intro_Date.csv) produced by the analysis of international
animal mobility in Tunisia done in Chapter 9.1.1 by using the function

Add Delimited Text Layer . Choose the appropriate CRS (the same as your project).

http://www.diva-gis.org/
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~���5 Go to the menu Vector » Data Management Tools »

Join Attributes by Location ( ).

Define the following parameters:
• Target vector layer: Select the layer defining the administrative divisions of Tunisia.
• Join vector layer: Select the SNA data layer.

• Geometric predicate: Tick all of the boxes available except Disjoint .
• Precision: Leave 0.
• Attribute summary: Select Take summary of intersecting features .
• Statistics for summary: Note max, because we increase the risk and only keep the

maximum value in each municipality.

• Joined table: Select Keep all records (including non-matching target records) .
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~���6 Finally, click on Run to create a new layer containing the mobility data.

NB For each administrative division, the highest in-degree is retained, since in qualitative
risk analysis, the principle of increased risk is applied.

~���7 Rename your Joined layer and save it as a shapefile (right click on the name of the layer

in the legend » Save as... ).

NB For greater clarity, delete the old layers.~���8 Explore the attribute table of your new main layer. You will see that, for most administrative
divisions, the column maxindegree (in-degree) is empty. You therefore will enter ‘0’.~���9 Use the tool ‘Select features using an expression’ ( ).~���10 Indicate the following expression:

"maxindegre" IS NULL

You are asking QGIS to select all administrative divisions which do not have an in-degree
value.~���11 Click on ‘Select’ then ‘Close’.

~���12 Once you are sure that the selection has been made, activate the ‘Toggle Edit’ mode ( )
and select ‘maxindegree’ in the upper left cell by using the drop-down menu available, enter
‘0’ in the blank box and click on ‘Update selection’.~���13 Close the ‘Toggle Editing’ mode, saving your changes, select your features/delegations/rows

( ) and close the attribute table.

We can now define four classes:

~���1 Open Layer Properties (right click on the name in the legend).
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(a) Go to the Style tab.

(b) Select Graduated instead of Single symbol .

(c) Indicate the name of the column in which you will work: maxindegree in this case.

(d) The ideal for numerical data is to choose as Mode of classification Quantiles (Equal

Count) . However, we see here that the very high number of ‘0’s in our data does not

allow us to create four classes using this mode. Try the different classification Modes

available and stop, for the exercise, on Natural Breaks (Jenks) , this mode proposes
classes of natural thresholds grouping similar values and optimizing the differences
between the classes.

(e) Indicate that you want four Classes .

The value intervals delimiting your classes are displayed:
• the administrative divisions have a very high in-degree if its value is between the

quantiles 8 and 17.
• the administrative divisions have a high in-degree if its value is between the quantiles 2

and 8.
• the administrative divisions have a low in-degree if its value is between the quantiles 0

and 2.
• the administrative divisions have a negligible in-degree if its value is 0.

Exercise 9.10 Do this step for your country.

NB The classification mode will depend on the distribution of your data.
Always start by testing the quantiles, and if they do not allow you to define four categories
then test the other classification modes to choose the most suitable one.
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Accessibility

Accessibility is also a quantitative risk. We will therefore proceed in the same way to determine the
four accessibility value categories for Tunisia.~���1 Import into QGIS (either in a new project, or in the one you used for the in-degree) the

borders of Tunisia with the ADMIN 2 division level.

~���2 Import the accessibility raster file (.tif) by using the function Add Raster Layer (see
Chapter 7.2.2).

~���3 For the analysis, you do not need the layer at the global level, just the data concerning Tunisia.
We therefore will clip the raster layer to the borders of Tunisia.

To do so, go to the menu Raster » Extraction » Clip ... .

(a) Indicate where you wish to save the new clipped layer and the name (.tif) you wish to
give it.

(b) Select the option Mask Layer , which means you wish to clip your raster by following
the contours of another layer.

(c) Select the layer delimiting the borders of Tunisia.

(d) Click on OK .

NB Clipping can take time so please be patient.
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We now will calculate the average accessibility for each administrative division.~���4 Use the menu Raster » Zonal Statistics » Zonal Statistics

NB The tool ‘Zonal Statistics’ is a plugin. If it does not appear on the Raster menu,

it means that you have not yet installed it. You can install it by going to the menu

Plugins » Manage and Install Plugins... and searching for the Zonal Statistics plugin .

Define the following parameters:

(a) Select your national accessibility raster layer.

(b) Select the administrative boundaries layer of Tunisia.

(c) Indicate ‘Access_’ as the Prefix in the output column

(d) Uncheck all of the boxes to only keep the mean.

(e) Click on OK .
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~���5 Open the attribute table of the administrative boundaries layer of Tunisia, you will see that at

the end a new column has been added: Access_mea .

We can now define our classes:

~���1 Open the Layer Properties of administrative boundaries (right click on the name in the
legend).

(a) Go to the Style tab.

(b) Select Graduated instead of Single symbol .

(c) Indicate the name of the column in which you wish to work: Access_mea in this
case.

(d) Choose Quantiles (Equal Count) as the Mode of classification.

(e) Indicate that you want four Classes .

The value intervals delimiting your quantiles are displayed:

NB Do not hesitate to modify the legend and the colours to better visualize your categories
on the map.
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~���2 Save this layer containing accessibility by Tunisian delegation in the shapefile format; you
will need it again later.

Exercise 9.11 Do this step for your country.

NB Using the ‘ Graduated’ classification style, you can define the quantiles of numerous
quantitative risk factors. Do not hesitate to use this tool to categorize other risk factors;
those used here were defined as an example for this exercise on Tunisia.
Do not hesitate to contact the team of expert trainers from CIRAD and EuFMD if you
need guidance on how to classify a risk factor (team.aqcr@cirad.fr).

�

9.1.3 Third step: Characterize the risk levels

Now that we know our risk factors and their classes, we will characterize the four levels of the risk
of introduction of FMD in Tunisia: very high, high, low and negligible.

In this exercise, we use the criteria defined by a group of experts in FMD and Tunisian animal
sectors. The experts considered together the following questions:

Under what conditions can one consider that an administrative division presents a very high
risk of introduction of the FMD virus?
Under what conditions can one consider that an administrative division presents a high risk
of introduction of the FMD virus?
Under what conditions can one consider that an administrative division presents a low risk of
introduction of the FMD virus?

As the objective was to weight the risk factors against each other, the experts engaged in lengthy
discussions to agree on the following characterization:
The risk is very high if the administrative division borders on Libya (see table for estimating the

risk of introduction), OR if the administrative division contains at least one illegal border

mailto:team.aqcr@cirad.fr
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crossing point OR if the in-degree of the administrative division is very high (between the
3rd and 4th quantiles), OR if its mean accessibility is very high (between the 3rd and 4th
quantiles);

otherwise the risk is high if the administrative division borders on Algeria (see table for estimating
the risk of introduction), OR if the administrative division contains at least one legal border
crossing point, OR if the in-degree of the administrative division is high (between the 2nd
and 3rd quantiles), OR if its mean accessibility is high (between the 2nd and 3rd quantiles);

otherwise the risk is low if the in-degree of the administrative division is low (between the 1st
and 2nd quantiles), OR if its mean accessibility is low (between the 1st and 2nd quantiles);

otherwise the risk is negligible .
These characteristics/conditions were then presented in table form:

Risk levels
Very high High Low

Borders Libya Borders Algeria
OR Illegal border crossing

point
Legal border crossing
point

OR in-degree between 8 and 17 in-degree between 2 and 8 in-degree between 0 and 2.
OR Mean access. between

160.45 and 600.15
Mean access. between
105.33 and 160.45

Mean access. between
34.36 and 105.33

All administrative divisions that do not meet any of the conditions in these three columns will
present a negligible risk of introduction.

Remember that in this exercise on FMD in Tunisia, we are working on various potential
routes of introduction of the virus: legal trade, illegal trade and non-commercial flows, such as
transhumance. These pathways of introduction present risk factors that we have defined for Tunisia:

What is the risk associated with each border?
∗ Each border is considered to be potentially porous with regard to illegal/undeclared trade.

We will therefore assign to each border administrative division the level of risk calculated in
9.1.2 for the given border.
∗ Illegal/undeclared trade is considered to be a major risk because it is not subject to any control.

We will therefore also assign a very high risk to all administrative divisions containing an
illegal border crossing point.

What are the risks respectively associated with legal and illegal imports?
∗ As we use the principle of increased risk, the maximum risk associated with legal trade will

be applied to all administrative divisions containing a legal border crossing point (See 9.1.2).
∗ As indicated above, all administrative divisions containing an illegal border crossing point

present a very high risk.

What is the risk associated with different mobility parameters?
∗ For both in-degree and accessibility (as they are quantitative variables), we class the

administrative divisions according to the quantiles that will reflect the four levels of risk.

Let us fill in the table together step by step.

Let’s start by taking a sheet of paper (or a digital spreadsheet e.g. Microsoft Excel) and making
three columns:
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Risk levels
Very high High Low

Border~���1 Return to the file Release_Proba-EN.xls .

~���2 Go to the right of the main table of the Surveillance & control sheet.

~���3 Click on the arrow in the header of the column Border and uncheck the box in front

(Empty) .~���4 Fill in the sheet of paper based on the levels of risk that are displayed.

For Tunisia:

Risk levels
Very high High Low

Borders Libya Borders Algeria

Trade~���1 Return to the file Release_Proba-EN.xls .

~���2 Go to upper left of the Surveillance & control sheet.

~���3 Complete your sheet of paper with the level of risk indicated in the Legal Trade row of the

table SUMMARY OF SCORES FOR YOUR COUNTRY . For illegal trade, we decided
that, regardless of the score calculated, all illegal border crossing points represented a very
high risk.

For Tunisia:

Risk levels
Very high High Low

Borders Libya Borders Algeria
Illegal border crossing point Legal border crossing point

Mobility (in-degree and accessibility)~���1 Complete your sheet of paper with the intervals of the four categories that you determined
for the in-degree and accessibility.

For Tunisia:
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Risk levels
Very high High Low

Borders Libya Borders Algeria
Illegal border crossing point Legal border crossing point
in-degree between 8 and 17 in-degree between 2 and 8 in-degree between 0 and 2.
Mean access. between
160.45 and 600.15

Mean access. between
105.33 and 160.45

Mean access. between
34.36 and 105.33

Exercise 9.12 Do this step for your country. Fill in the gaps in the text below and produce a
table of the associated risks.
I “The risk of introduction is very high if..., otherwise the risk is high if..., otherwise the

risk is low if..., otherwise the risk is negligible.”

NB The [...] can be filled in with several conditions separated by ‘OR’, and the conditions can
be defined by a combination of conditions connected by ‘AND’.

Risk levels
Very high High Low

NB If you have any doubts, do not hesitate to refer to the presentation of the method
(section 4.3 page 23), or to contact the team of expert trainers at CIRAD and EuFMD
(team.aqcr@cirad.fr).

�

9.1.4 Fourth step: Mapping the risk of introduction of FMD in Tunisia

Now that we have characterized our risk levels and have all our data, all we need to do is the actual
risk mapping. This step is done with QGIS.~���1 Open QGIS – if you need help to install or use QGIS, go to Chapter 7.~���2 Create a new project.

Import the data needed for the analysis

Borders and administrative divisions

As you did when categorizing accessibility, use the Add Vector Layer function (see
Chapter 7.2.2), to import the administrative borders of Tunisia and its bordering countries.~���1 Import the administrative division level admin2 representing the boundaries of Tunisian

delegations.~���2 Download on DIVA-GIS the frontiers of the bordering countries: Libya and Algeria. Import
the administrative division levels admin0 of Libya and Algeria. These division levels
represent the respective borders of these two countries.

mailto:team.aqcr@cirad.fr
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Border crossing points~���1 Import the border crossing points using the file that you downloaded in Chapter 9.1.1. To do

so, use the function Add delimited text layer ( ) (if you have any doubts as to how to
proceed, go to Chapter 7.2.2).

~���2 Split the border crossing points layer into two layers depending on whether they involve
official/controlled/legal movements or unofficial/uncontrolled/illegal movements. To do so,

go to the menu Vector » Data Management Tools » Split Vector Layer ( ). Define
the following parameters:
• Input layer: your border crossing points layer.

• Unique ID field: your MODE column.
• Output directory: choose the directory where you wish to save the two layers produced.~���3 Finally, click on Run to launch the creation of the two layers.
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~���4 Import these vector layers BORDER_CROSSING_POINTS_NC.shp (NC : not controlled)

and BORDER_CROSSING_POINTS_C.shp (C : controlled) with the tool Add vector layer

( ).

NB For greater clarity, you can delete the former layer BORDER_CROSSING_POINTS .

In-degree~���1 Import the vector file containing the SNA data (sna_Intro_Date) that you created in section
9.1.2.

Accessibility~���1 Finally, import the vector file containing the mean accessibility by delegation that you created
in section 9.1.2.

Let’s gather all the data in the same shapefile

Borders and administrative divisions
We will start from the layer representing the administrative divisions of Tunisia; it will be called
the main layer in the remainder of the exercise. First, we will seek to identify the administrative
divisions that share a border with Algeria and Libya.
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~���1 Open the attribute table of your main layer (TUN adm2).~���2 Create a new column for each bordering country: Algeria , Libya .

(a) Activate the ‘Toggle editing’ mode.

(b) Click on the icon .

(c) Successively add the two columns of whole numbers (whole).

(d) Close the ‘Toggle Editing’ mode and save your changes.~���3 Close the attribute table.~���4 Use the menu Vector » Research Tools » Select by Location .

Define the following parameters:
• Layer where the selection is to be made: Select the main layer delimiting the borders of

your country.
• Supplementary layer (intersection layer): Select the layer of the bordering country in

which you are interested, for example, Algeria.

• Geometric predicate: Tick all of the boxes except Disjoint .
• Precision: Leave 0.
• Modify current selection in: Select Create a new selection .
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~���5 Click on Run and be patient because the selection can take some time.~���6 Check that all administrative divisions sharing a border with Algeria have been selected; they
must appear in yellow.

NB Be careful, if the accessibility and in-degree layers are on top of your main layer, i.e.
higher in the legend, you will not see the selection on the map. Move the main layer
above the others if needed.

If some border municipalities have not been selected, use the function: Select Features with a

rectangle or a single click ( ), hold down the shift key and add the missing administrative
divisions to your selection.
We shall now enter 1 in the column Algeria for all of its administrative divisions.~���7 Open the attribute table of your main layer.

~���8 Activate the ‘Toggle Editing’ mode ( ).
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~���9 Select the column Algeria in the upper left between the ‘Edit’ button and the attribute table.~���10 Enter 1 in the blank box at the top.

~���11 Click on Update Selected .

~���12 Close ‘Toggle Editing’ ( ) and save your changes.

~���13 Repeat the manoeuvre (points 3 to 10) for Libya.~���14 Close the attribute table.

Border crossing points

We want to know, for each administrative division, whether it receives at-risk animals imported
from abroad and, if so, by which route (controlled/legal or uncontrolled/illegal). We will therefore
count the number of legal and illegal border crossing points per administrative division.

NB Before starting any new action, always verify that you no longer have any feature selected

( ).

~���1 Use the menu Vector » Analysis Tools » Count points in polygon
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~���2 Define the following parameters:
Polygons: Select your main layer.
Points: Select the layer of controlled border crossing points.

Count field name: Set the name of the new column. For example: C_crossing_points .

~���3 Click on Run

A new layer was generated in which your column was added. Save this new layer as a
shapefile; this is your new main layer.

NB For greater clarity, you can delete the layers ‘Count’, ‘TUN_adm2’ and
‘BORDER_CROSSING_POINTS_MODE_C’.
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~���4 Repeat the operation for the illegal border crossing points. Remember to select the new layer

as the main layer and to put a different column name, for example: NC_ crossing_points .

You now have information about the border countries and the border crossing points of at-risk
animals in the same layer (you can check in the attribute table).

In-degree
We must now add to each administrative division the in-degree associated with it. To do so:~���1 Open the attribute table of the layer containing the in-degrees ("maxindegree").~���2 Activate the ‘Toggle Editing’ mode.~���3 Delete all of the columns ( ), except the column "maxindegree".~���4 Close the ‘Toggle Editing’ mode and save your changes.~���5 Close the attribute table.

~���6 Make sure that no feature is selected ( ).

~���7 Go to the menu Vector » Data Management Tools » Join attributes by location ( ).
Define the following parameters:
• Target vector layer: Select your main layer.
• Join vector layer: Select the layer containing the in-degree.

• Geometric predicate: Only check the box Equals .
• Precision: Leave 0.
• Attribute summary: Select Take the attributes of the first located feature .
• Statistics for summary: Enter nothing (this is only if you wish an attributes summary).

• Joined table: Select Keep all records (including non-matching target records) .
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~���8 Finally, click on Run to create a new layer containing the data on mobility, borders and
border crossing points. This is now your new main layer.~���9 Delete the old main layer.~���10 Save the new Couche jointe in shapefile format (right click on the name of the layer in the

legend » ESave as... ) as your new main layer.

NB For greater clarity, you can delete the older layers: the in-degree layer and the joined
layer.

Accessibility

You now only have to add an accessibility parameter for each administrative division. We will
proceed in the same way as we did for in-degree.

~���1 Open the attribute table of the accessibility layer.~���2 Activate the ‘Toggle Editing’ mode.~���3 Delete all of the columns except the column "Access_mea".~���4 Leave the ‘Toggle Editing’ mode and save your changes.~���5 Close the attribute table.

~���6 Make sure that no feature is selected ( ).

~���7 Go to the menu Vector » Data Management Tools » Join attributes by location ( ).
Define the following parameters:
• Input vector layer: Select your main layer.
• Join vector layer: Select the layer containing the mean accessibility per Tunisian

delegation.

• Geometric predicate: Only check the box Equals .
• Precision: Leave 0.
• Attribute summary: Select Take attributes of the first located feature .
• Statistics for summary: Enter nothing (this is only if you wish an attributes summary).

• Joined table: Select Keep all records (including non-matching target records) .
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~���8 Finally, click on Run to create a new layer containing accessibility, in-degree, borders and
border crossing points. This is now your new main layer.~���9 Delete the old main layer.~���10 Save the new Joined layer in shapefile format (right click on the name of the layer in the

legend » Save as... ) as your new main layer.

NB For greater clarity, you can delete the older layers: the accessibility layer and the
joined layer.

All of your data should now be in the same layer. Remember to save it. This is your main layer,
the one that we will use for the final mapping. Take time to explore the attribute table of this new
main layer to fully understand what you have done.

Let’s map the risk of introduction

You now have everything in hand to start estimating and mapping the areas at risk! We will highlight
the administrative divisions associated with each level of risk of introduction.~���1 Open the attribute table of your main layer.~���2 Create a new field in which the level of risk of introduction will be defined.
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(a) Activate the ‘Toggle Editing’ mode.

(b) Add a new field.

(c) Name this field ‘Intro’.

(d) Define it as a ‘Whole number (integer)’,

(e) with a length ‘1’.

NB NWe are going to discriminate four levels of risk
1 ⇒ Risk Negligible

2 ⇒ Risk Low

3 ⇒ Risk High

4 ⇒ Risk Very High

(f) Validate by clicking on OK .

(g) Save your changes.

(h) Leave the ‘Toggle Editing’ mode.~���3 We now will update this field using the Field Calculator : Check that no row is selected

( ) and click on the icon: .
We will use an expression describing the criteria characterizing very high risk, high risk and
low risk. The administrative divisions that do not meet any of these criteria will present a
negligible risk.
Reminder on the characterization of risk levels:
• If an administrative division borders on Libya, if it has an illegal border crossing point,

if its in-degree is between 8 and 17 or if its mean accessibility is between 160.45 and
600.15, then it is considered to present a very high risk (4) for the introduction of FMD.
• Otherwise, among the remaining administrative divisions, if an administrative division

borders on Algeria, if it has a legal border crossing point, if its in-degree is between 2
and 8 or if its mean accessibility is between 105.33 and 160.45, then it is considered to
present a high risk (3) for the introduction of FMD.
• Otherwise, among the remaining administrative divisions, if an administrative division

has an in-degree between 0 and 2 or if its mean accessibility is between 34.36 and
105.33, then it is considered to present a low risk (2) for the introduction of FMD.
• All other administrative divisions are considered to present a negligible risk (1) for the

introduction of FMD.

NB As a reminder, the thresholds of the categories of the qualitative risk factors, in-degree
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and accessibility, were defined in Section 9.1.2 as a function of respectively natural
breaks and quantiles.

Characterization in EXPRESSION in QGIS

if( "Libya" > 0 OR

"NC_crossin" > 0 OR

("maxindegre" <= 17 AND "maxindegre" > 8) OR

("Access_mea" <= 600.15 AND "Access_mea" > 160.45),

4,

if( "Algeria" > 0 OR

"C_crossing" > 0 OR

("maxindegre" <= 8 AND "maxindegre" > 2 ) OR

("Access_mea" <= 160.45 AND "Access_mea" > 105.33),

3,

if (("maxindegre" <= 2 AND "maxindegre" > 0 ) OR

("Access_mea" <= 105.33 AND "Access_mea" > 34.36),

2,

1

)))

~���4 In the field calculator:

(a) Tick ‘Update existing field’.

(b) Select the field ‘Intro’.

(c) Copy the expression above in the dedicated frame (empty frame under ‘Expression’).

(d) Click on OK.

~���5 Leave the ‘Toggle Editing’ mode, save your changes and close the attribute table.

All that remains to be done is to change the Style of your layer to produce your final map of
the risk of introduction.

~���1 Open the properties of your main layer (right click on the name of the layer in the legend).~���2 In the Style tab:
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(a) Select Categorized in the place of Single symbol .

(b) Select the column Intro that you just updated with the risk of introduction of FMD
in Tunisia.

(c) Click on Classify .

(d) Adjust the legend and the colours.

(e) Click on OK .

Exercise 9.13 Do this 4th step for your country.

NB If you run into difficulties, do not hesitate to turn to the video tutorial and slide presentation.
Also remember that the team of expert trainers at CIRAD and EuFMD can help you
(team.aqcr@cirad.fr).

�

mailto:team.aqcr@cirad.fr
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Congratulations, if you have successfully completed all of these steps. You have produced a
map of the risk of introduction of FMD for Tunisia!! Try and apply the framework to your

country!

9.2 Risk of exposure

A video tutorial and a slide presentation describing
in detail the steps of the analysis are available.

Risk of Exposure Application

Objective

In this second stage, we are seeking to estimate and map the risk of endemicity and spread of the
FMD virus in Tunisia, known as the risk of exposure.

9.2.1 First step: What are the risk factors that could lead to the establishment and spread
of the disease in your country?

Define the risk factors

The first step is to identify the factors facilitating the endemicity and/or spread of FMD once the
disease has been introduced into Tunisia. We are talking about risk factors leading to or facilitating
the establishment and spread of the disease.

We propose to work on the risk factors that were defined and validated by experts when the
method was applied for FMD in Tunisia. These factors are:
Animal density of cattle and small ruminants (goats/sheep)

The introduction of the virus can lead to an epizootic and spread only in the presence
of susceptible animals. This has been confirmed by numerous studies showing a strong
correlation between the density of cattle and small ruminants and the occurrence of an FMD
epizootic (Dukpa et al., 2010; Hegde et al., 2014). Furthermore, it is known from experience
that controlling an FMD epizootic is more difficult in areas with a high density of ruminants
(Bouma et al., 2003; Muroga et al., 2012; Park et al., 2013).

Road density
The spread of FMD is influenced by road density, especially during the early stages of an
epizootic (Rivas et al., 2003; Traulsen, 2009). For Tunisia, the experts considered that the
road network was more representative of the main axes of mobility than the accessibility
map. We therefore will consider that the denser the road network, the higher the probability
of encountering an infected animal, meaning the probability of disease spread increases with
road density.

Presence/Absence of live animal markets
Live animal markets, animal fairs and communal pastures are gathering places where animals
are in close contact with one another. These animal gathering places facilitate the infection
of new animals and therefore the spread of the virus (Abbas et al., 2012).

Presence/Absence of fattening units
Like live animal markets, fattening units bring together many animals from different parts of
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the country before they are redispersed over the country. These are the places conducive to
the large-scale transmission and spread of the virus (Gezahegn et al., 2014; Lindholm et al.,
2007).

Presence/Absence of a water point
On the same principle as live animal markets and fattening units, watering areas are known to
be an important risk factor for the spread of FMD. This factor is even more important if the
location has the potential to gather wild and domestic animals (Abbas et al., 2012; Hayama
et al., 2016; Wungak et al., 2016).

Two parameters of animal mobility
Animal mobility is known for its important role in the introduction of the virus (Ayelet et al.,
2012), as well as for its role in maintaining the circulation of the virus during an epizootic
(Gibbens et al., 2001). As we did for the risk of introduction, we can analyse animal mobility
by performing a social network analysis (SNA) (Ortiz-Pelaez et al., 2006).SNA makes it
possible to represent networks in the form of nodes (places in our case) connected to each
other by oriented links (animal flows in our case). In contrast with the analysis of the risk of
introduction, we now will focus on animal mobility within the country. We therefore will
study domestic flows and not cross border flows. For this study, we use as risk factors two
parameters derived from the analysis of the national animal mobility network:
Degree is a mobility parameter that represents the number of flows (incoming and outgoing)

associated with a locality (if required, a more detailed definition is provided in Annex
9.2.4).

Betweenness centrality is a mobility parameter that makes it possible to assess the
importance of a locality in a network. It will highlight notably the localities representing
essential bridges (meaning that link other localities to each other via this intermediary).
The more a locality is in contact with different localities, the higher its betweenness
centrality will be; it will be even higher if it is the only locality connecting various
groups.

Exercise 9.14 Consider the risk factors of exposure to the FMD virus for your territory. What
are the factors required for the establishment of the disease? What are the factors facilitating its
spread?

List all of the risk factors that you can think of, then select the main ones.
In this example, we present seven risk factors to use a maximum number of examples. However,
try to limit yourself to a maximum of five or six risk factors. You can draw inspiration from the
list (non-exhaustive) presented in Annex page 121.

NB By definition, the risk factors defined for the risk of exposure are different than those for
the risk of introduction.

�

Define your work scale

Like for the risk of introduction, we will work at the level of Tunisian delegations (Admin2). It is
the smallest scale available in open access on DIVA-GIS.

Collect the data

As with the risk of introduction, we suggest you use open access data when available and the
fictitious data that we created for this exercise. When you conduct the exercise for your territory,
keep in mind that all data must be validated by local experts and can be modified, supplemented
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according to your knowledge, to current events, or by conducting field surveys.

Animal density of cattle and small ruminants (goats/sheep). Animal density maps/raster are
available in open access on the FAO site – GeoNetwork.~���1 Go to the FAO GeoNetwork website: http://www.fao.org/geonetwork/srv/en/main.home.~���2 On the upper left-hand side of the page, in the blank box under the question “WHAT?”, enter

that you are looking for ‘cattle density’.~���3 Below, under the question ‘WHERE?’ use the drop-down menu to select ‘Tunisia’.~���4 Click on ‘Search’.
You should see displayed in the panel on the right different maps, including ‘Cattle distribution
- Gridded Livestock of the World v 2.01’~���5 Click on ‘Download’ then on a link next to ‘Data to download’, for example: Global model
of cattle density (GLW 2.01) Cell resolution 0.08333333; AD stands for animal density; The
year of reference is 2010 (country totals are adjusted to FAOSTAT values in 2010) GeoTiff~���6 A zip file is downloaded, and you can unzip it to access the raster file (.tif).~���7 Repeat the same operation to download the small ruminant density (or goat density and sheep
density) data.

Road density Road density is freely available on the DIVA-GIS website.~���1 Go to the DIVA-GIS website: http://www.diva-gis.org/.~���2 Click on ‘free spatial data’.~���3 Click on ‘Country level data’.~���4 Use the drop-down menu under ‘Country’ to select ‘Tunisia’.~���5 Use the drop-down menu under ‘Subject’ to select ‘Roads’.~���6 Click on OK.~���7 Click on ‘Download’.~���8 A zip file is downloaded, and you can unzip it to access the shapefile file (.shp).

Gathering areas: water points, live animal markets, fattening centres A large amount of
data on the water network is available on the DIVA-GIS website. You also can identify the watering
points yourself in your territory.

For this exercise, we will assume that a survey was conducted on the Tunisian territory to
identify the gathering areas of small ruminants and cattle. This fictitious survey has identified the
information necessary to complete the GATHERING_AREAS.csv table. Download this file to be
able to continue the exercise.

http://www.fao.org/geonetwork/srv/fr/main.home
http://www.fao.org/geonetwork/srv/en/main.home
http://www.fao.org/geonetwork/srv/en/main.home
http://www.fao.org/geonetwork/srv/en/resources.get?id=47949&fname=Cattle10km_AD_2010_GLW2_01.zip&access=private
http://www.fao.org/geonetwork/srv/en/resources.get?id=47949&fname=Cattle10km_AD_2010_GLW2_01.zip&access=private
http://www.fao.org/geonetwork/srv/en/resources.get?id=47949&fname=Cattle10km_AD_2010_GLW2_01.zip&access=private
http://www.diva-gis.org/
http://www.diva-gis.org/
http://www.diva-gis.org/
http://www.diva-gis.org/
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Animal mobility parameters: degree and betweenness centrality If you have already analysed
the animal mobility of your country (for example by carrying out the analysis of the risk of
introduction - part 9.1.1, take the file sna_Expo_Date generated during the network analysis carried
out as part of the work on the risk of introduction and proceed to Step 2 (Part 9.2.2 page 95).

If that is not the case, complete the following steps:
To calculate animal mobility parameters, you must identify the different flows of live animals

susceptible to the disease that take place in Tunisia. For the purpose of this exercise, we will assume
that a survey was conducted that enabled us to fill in the file ANIMAL_MOBILITY.csv. Download
this file to complete the continuation of the exercise.

NB You will notice that this file identifies national and international animal flows. Keep in
mind that for the risk of exposure, we will only be interested in national animal mobility
(movements from one place in Tunisia to another place in Tunisia, for example from a
breeding area to a market).

Let’s carry out the analysis of national animal mobility based on these data by using the R
software.~���1 Download the latest version of the network analysis R script: SNA-EN.R .~���2 Open the file in R or RStudio – the illustrations in this tutorial use the RStudio interface (if

you need help to install and launch R or RStudio, go to Chapter 8).~���3 Scroll down the script to reach the section:

######################################

## Define the location of your file ##

## and the name of your countrys ##

######################################
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~���4 Enter here the path to the folder where you want to save the results and ensure that the
country name written in uppercase in quotation marks is Tunisia. Note, the ‘\’ in Windows
must be replaced by ‘/’ or ‘\\’ in the path of your folder and the name of the country must be
spelled as in the file ANIMAL_MOBILITY.csv. Example:

setwd("C:/SQRA/Data/SNA")

my_country <- "TUNISIA"

~���5 Run the script by clicking Ctrl + A to select the entire script, then Ctrl + Enter to start
the script.~���6 A window will open to let you select the file with the animal movements describing the
mobility network. If the window does not appear, verify that it did not open behind RStudio.~���7 Once you have selected your data file "ANIMAL_MOBILITY", click on Open .~���8 Graphs appear in the lower right-hand section. Once the scan is completed, you can look at
all of them by using the arrows at the top left of the graph.~���9 At the end of the analysis, four text files (.csv) will automatically be saved in the folder that
you specified in the beginning. The file that interests you is called sna_Expo_Date.csv; the
word ‘date’ will be replaced by the date of the day you conduct the analysis.

Exercise 9.15 Do this step for your country.
Use as a priority the national data available and, when necessary, organize surveys to produce

tables equivalent to those we produced for this exercise.
For the gathering areas:

1. Create a table (Microsoft Excel or OpenOffice Calc).

2. Create four columns that you name:
NAME Name of location (optional)
TYPE Type of data (Point_Water, Market, Fattening, etc.)
LONGITUDE_X in decimal degrees (i.e. Airport of Tunis: 10.219074500000033)
LATITUDE_Y in decimal degrees (i.e. Airport of Tunis: 36.8458578)
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3. Fill in the columns.

NB If needed, you can use this tool for the GPS coordinates:
https://www.gps-coordinates.net/gps-coordinates-converter.
The types must ALWAYS be written in the same way because, during the analysis,
we will separate the data according to this column.

4. Save in CSV format.

For animal mobility:
1. Also create a new table, but this time with nine columns that you name:

ORIGIN_NAME
ORIGIN_COUNTRY
ORIGIN_LONGITUDE_X
ORIGIN_LATITUDE_Y
DESTINATION_NAME
DESTINATION_COUNTRY
DESTINATION_LONGITUDE_X
DESTINATION_LATITUDE_Y
HEADCOUNT

NB Write the names in upper case without accents and take care to use consistent
spelling. Write the longitudes and latitudes in decimal degrees. You can do the
analysis without the headcount, but the analysis will be more precise if you have
this data.

2. Fill in the columns with your data.

3. Save in CSV format.

�

9.2.2 Second step: Categorize the risk factors

Now that we have gathered all the data, we need to define categories for each risk factor. Remember
that the classification method changes depending on the nature of the data and thus will not be the
same for all risk factors:
Qualitative variables: Presence/absence, nearby/distant, few/moderate/many etc. In this case, the

categories are generally fairly evident.
Quantitative variables: Quantitative data (for example: number of heads per km2, average travel

time from one area to another, etc.). For this type of variable, we recommend a division into
four classes whose thresholds are defined by quantiles: negligible risk [0-1st quantile]; low
risk [1st quantile-2nd quantile]; high risk [2nd quantile-3rd quantile]; very high risk [3rd
quantile-4th quantile]. However, you may encounter other situations where the distribution
of data or quantiles are not suitable. If that is the case, you must select another mode of
classification.

The following step was carried out using QGIS.

NB As for the risk of introduction, all explanations and screen shots are based on the use of
version 2.18.25 of QGIS.

~���1 Start by opening a new project in QGIS.~���2 Import the administrative boundaries of Tunisia (adm2) as you did for the qualitative and
cartographic analysis of the risk of introduction of FMD (see Chapter 9.1.2).

https://www.gps-coordinates.net/gps-coordinates-converter


96 Chapter 9. Application of the method: case of Tunisia

Animal density of cattle and small ruminants (goats/sheep).

~���1 Import the animal density layers using the tool Add Raster Layer... ( ). If you have
any doubts, refer to Chapter 7.2.2.~���2 Add together the small ruminant density raster and the cattle density raster to obtain a new

‘DENSITY_ANIMAL’ raster. To do so, use the Raster Calculator... tool that you will find

in the Raster menu.

(a) Indicate in the output layer section the placement and name that you wish to give
your new Raster.

(b) Use the Raster bands and the available Operators to write in the Raster calculator

expression field: “name of you cattle density Raster” + “name of your small ruminant
density Raster”.

(c) Click on OK .

~���3 Clip the new raster by following the administrative boundaries of Tunisia using the Clipper tool...

on the menu Raster » Extraction

(a) Select in Input file (raster) the DENSITY_ANIMAL layer that you want to clip.

(b) Below, in Output file , indicate where you wish to save the clipped file and the name
you wish to give it.
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(c) Select Mask layer in Clipping mode .

(d) Use the drop-down menu to select the layer representing the administrative division of

Tunisia (TUN_adm2) as the Mask layer .

(e) Click on OK and when the process is finished, click on Close .

NB You can delete the global layers and only keep the national layer with the sum of
densities, i.e. the newly created raster DENSITY_ANIMAL.

Let’s calculate the mean density for each administrative division.~���4 Use the menu Raster » Zonal Statistics » Zonal Statistics

NB The tool ‘Zonal Statistics’ is a plugin. If it does not appear on the Raster menu,

it means that you have not yet installed it. You can install it by going to the menu

Plugins » Manage and Install Plugins ... and searching for the ‘Zonal Statistics’

plugin.~���5 Define the following parameters:

(a) Select you animal density raster layer .

(b) Select the layer representing the administrative divisions as the Polygon layer containing

the zones .
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(c) Specify a prefix of the output column (for example: ‘DENS_ANIMAL_’ for density).

(d) Uncheck all of the boxes to only keep the mean.

(e) Click on OK .

~���6 Open the attribute table of your main layer (the one with the administrative boundaries), a

new column has been added at the end: DENS_ANIMAL , and you can now delete the
animal density raster as you no longer need it.

We now will categorize the ‘animal density’ risk factor.

~���1 Open the Layer Properties table (right click on the name in the legend).

(a) Go to the Style tab.

(b) Select Graduated .

(c) Select your Mean Density column.

(d) In the part, Classes , specify that you want to classify your data in four quantiles
(equal count).

(e) Click on Classify .
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~���2 Note on a piece of paper the category intervals for the risk factor “Animal Density”.
Example:

Animal density Values
Very high > 116.14
High [82.36 ; 116.14]
Low [39.31 ; 86.36]
Negligible < 39.31~���3 Save the layer. You will use it for mapping the risk of exposure.

Road density We will proceed in approximately the same way for road density as we did for
animal density. We are going to calculate the total length of the roads in each administrative
division, then divide this by the surface area of the administrative division.~���1 Import the vector layer illustrating the road network of Tunisia. Calculate the total length of

roads in each administrative division by going to the Vector menu and using Analysis Tools

» Sum Line Lengths , which you will set up as shown below:

(a) Indicate your road network layer in Lines .

(b) Indicate your main layer (layer with the administrative boundaries) in Polygons .

(c) Indicate the name you wish to give the column indicating the sum of the road lengths

in Lines length field name , for example: ROADS_LG.

(d) Note the name you wish to give the column indicating the number of roads in Lines length

field name , for example: ROADS_NB.

(e) Click on Run .
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A new layer is created under the name Line Length .

~���2 Save this new layer as your main layer (right click on the name of the layer in the legend »

Save as... ).

~���3 Open the attribute table ( ) of this newly saved layer.

~���4 Activate the ‘Toggle Editing’ mode ( ) and open the field calculator ( ).~���5 Create a new field that you call “AREA”. QGIS will automatically calculate the surface area
in km2 of each administrative division if you enter the expression:

$area / (1000*1000)
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~���6 You can now calculate the road density by dividing total road length by area. To do so,
use again the field calculator to create a new field (real decimal number) that you name
‘DENS_ROAD’. As road length is indicated in meters, use the following expression:

"Route_long" * 1000 / "Surface"

~���7 Then leave the ‘Toggle Editing’ mode, save your changes and close the attribute table.

We now will categorize the ‘road density’ risk factor.

~���1 Open the properties of your main layer (right click on the name of the layer in the legend).

(a) Go to the Style tab.

(b) Select Graduated .

(c) Select your Road Density column.

(d) In the part, Classes , specify that you want to classify your data in four quantiles
(equal count).

(e) Click on Classify .
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~���2 Note on a piece of paper the category intervals for the risk factor “Road Density”.
Example:

Road density Values
Very high > 1.2535
High [0.7655 ; 1.2535]
Low [0.4688 ; 0.7655]
Negligible < 0.4688~���3 Save the layer containing the road density values for each delegation. You will need it for the

map.

Gathering areas: water points, live animal markets, fattening units In the exercise, we
decided that water points, live animal markets and fattening units would be considered qualitative
variables with two categories: Presence/Absence (without considering quantity).

Animal mobility parameters: degree and betweenness centrality For the quantitative risk
factors such as degree and betweenness centrality (a quantifiable numerical value is associated with
each locality in the network), we will distinguish four categories based on quantiles.

As a reminder: When you did the SNA in section 9.1.1, four CSV files were created:
sna_Intro Contains the mobility parameters for all of the locations in your international animal

mobility network (this will not be used for the analysis of the risk of exposure).
qtl_Intro Contains the quantiles of the parameters calculated for your international network (this

will not be used for the analysis of the risk of exposure).
sna_Expo Contains the mobility parameters for all locations in your national animal mobility

network.
qtl_Expo Contains the quantiles of the parameters calculated for your national network.

In the file qtl_Expo, you will find an initial approximation of quantiles calculated for the
in-degree. These quantiles could be the limits of your four categories. However, we are working on
the scale of the delegation (administrative division adm2). Quantiles must therefore be calculated
from a dataset containing a single value by delegation. We will therefore do this step using QGIS.
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~���1 Open a new project in QGIS.~���2 Import the administrative boundaries of Tunisia (adm2).~���3 Import the SNA data file (sna_Expo_Date) produced by the analysis of international animal

mobility in Tunisia done in the 1st step (Chapter 9.2.1) by using the function Add Delimited

Text Layer ( ).

~���4 Go to the menu Vector » Data Management Tools » Join attributes by location ( ).

Define the following parameters:
• Input vector layer: Select the layer delimiting the borders of Tunisia.
• Join vector layer: Select your SNA data layer.

• Geometric predicate: Tick all of the boxes except Disjoint .
• Precision: Leave 0.
• Attribute summary: Select Take summary of intersecting features .



104 Chapter 9. Application of the method: case of Tunisia

• Statistics for summary: Note max , because we increase the risk and only keep the
maximum value in each municipality.

• Joined table: Select Keep all records (including non-matching target records) .

~���5 Finally, click on Run to create a new layer containing the mobility data.

~���6 Save your Joined layer as a shapefile (right click on the name of the layer in the legend »

Save as... ).~���7 Explore the attribute table. You will notice that the columns maxdegree (degree) and
maxbetween (betweenness centrality) contain empty boxes: They are the administrative
divisions which do not contain any origin or destination of the animal mobility network
which we described in the file ANIMAL_MOBILITY.csv. You therefore should enter ‘0’ in
these boxes.~���8 Use the tool ‘Select features using an expression’ ( ).~���9 Indicate the following expression:

"maxdegree" IS NULL

QGIS will select all administrative divisions which do not have a degree value.~���10 Click on ‘Select’ then ‘Close’.
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~���11 Once the selection is complete, activate the ‘Toggle Editing’ mode ( ).

(a) Select ‘maxdegree’ by using the drop-down menu in the upper left above the table.

(b) Enter ‘0’ in the empty box and

(c) Click on Update Selected.~���12 Repeat the same manoeuvre for the betweenness centrality.

~���13 Close the ‘Toggle Editing’ mode, save your changes, and deselect all features ( ).

We can now define our classes:

~���1 Open Layer Properties (right click on the name in the legend).

(a) Go to the Style tab.

(b) Select Graduated .

(c) Indicate the name of the column in which you wish to work: maxdegree for example.

(d) Choose Quantiles (Equal Count) as the Mode of classification.

(e) Indicate that you want four .

Quantiles does not let you define four categories. The Natural Breaks (Jenks) classification
must therefore be used.
The value intervals delimiting your categories are displayed:
• the localities have a very high degree if the value is between 10 and 23.
• the localities have a high degree if the value is between 5 and 10.
• the localities have a low degree if the value is between 1 and 5.
• the localities have a negligible degree if the value is between 0 and 1.
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~���2 Repeat the classification by selecting the column ‘maxbetween’.
The value intervals delimiting your categories are displayed:
• the localities have a very high betweenness centrality if the value is between 10.792

and 44.717.
• the localities have a high betweenness centrality if the value is between 4.208 and

10.792.
• the localities have a low betweenness centrality if the value is between 0 and 4.208.
• the localities have a negligible betweenness centrality if the value is equal to 0.~���3 Save your file as a shapefile. You will need it to continue the exercise.

Exercise 9.16 Do this step for your country.

NB It is possible that the quantiles allow you to define four categories, but this is not certain.
You can test the different classification modes to choose the one most adapted to the data
distribution.

�

9.2.3 Third step: Characterize the risk levels

Now that we know our risk factors and their classes, we will characterize the four levels of risk of
exposure of FMD in Tunisia: very high, high, low and negligible.

In this exercise, we assume that you gathered a group of experts on FMD and Tunisian sectors
to answer the following questions:

In Tunisia, under what conditions can one consider that an administrative division presents a
very high risk of exposure of FMD?

In Tunisia, under what conditions can one consider that an administrative division presents a
high risk of exposure of FMD?

In Tunisia, under what conditions can one consider that an administrative division presents a
low risk of exposure of FMD?
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One may deduce that all administrative divisions that do not meet any of these conditions present a
negligible risk of exposure.

As the objective was to weight the risk factors against each other, the experts engaged in lengthy
discussions to agree on the following characterization:

The risk is very high if animal density is very high AND there is at least one live animal market,
OR if road density OR degree OR the betweenness centrality is very high, OR if the
administrative division contains a fattening plant, OR a water point.

otherwise the risk is high if animal density is very high, OR if animal density is high in the
presence of a live animal market, OR if road density, OR degree, OR betweenness centrality
is high.

otherwise the risk is low if animal density is very high, OR if animal density is high in the
presence of a live animal market, OR if road density OR degree, OR betweenness centrality
is high.

otherwise the risk is negligible .

These characteristics/conditions were then re-transcribed in the form of the table below:

The risk level is...
Very high, if High, if Low, if

Animal density (VH) AND
Market (Presence)

Animal density (VH) Animal density (H)

OR Road density (VH) Animal density (H) AND
Market (Presence)

Animal density (L) AND
Market (Presence)

OR Degree (VH) Road density (H) Road density (L)
OR Betweenness centrality

(VH)
Degree (H) Degree (L)

OR Fattening unit (Presence) Betweenness centrality (H) Betweenness centrality (L)
OR Water point (Presence)

Exercise 9.17 Do this step for your country, weighing the risk factors against each other.
• Complete the gaps in the text below.

“The risk is very high if..., otherwise the risk is high if..., otherwise the risk is low if...,
otherwise the risk is negligible.”

• Fill in the table based on your text.

NB The [...] can be filled in with several conditions separated by ‘OR’, and the conditions can
be defined by a combination of conditions connected by ‘AND’.

Risk levels
Very high High Low

NB If you have any doubts, do not hesitate to refer to the presentation of the method
(section 4.3 page 23), or to contact the team of expert trainers at CIRAD and EuFMD
(team.aqcr@cirad.fr).

�

mailto:team.aqcr@cirad.fr
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9.2.4 Fourth step: Mapping the risk of exposure

Now that we have characterized our risk levels, and have all our data, all we need to do is make the
map of the risk of exposure. This step is done with QGIS.

~���1 Open QGIS.~���2 Create a new project.

Import the data needed for the analysis

Animal density of cattle and small ruminants (goats/sheep). Import the animal density layer
that you created when you classified this risk factor.

Road density Import the road density layer that you created when you classified this risk factor.

Gathering areas: water points, live animal markets, fattening units

~���1 Import the gathering areas using the file GATHERING_AREAS that you downloaded in

Chapter 9.2.1. To do so, use the function Add delimited text layer ( ) (if you have any
doubts as to how to proceed, go to Chapter 7.2.2).
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~���2 Spit the gathering areas layer into three layers according to whether it refers to water

points, fattening units, or live animal markets. To do so, go to the menu Vector »

Data Management Tools » Split Vector Layer ( ).

Define the following parameters:
• Input layer: Your layer of gathering areas.

• Unique ID field: Your TYPE column.
• Output directory: Choose the directory where you wish to save the three layers

produced.~���3 Finally, click on Run to launch the creation of the three layers.
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~���4 Import the vector layers GATHERING_AREA_TYPE_FATTENING.shp (FATTENING:
fattening unit),

GATHERING_AREA_TYPE_MARKET.shp (MARKET: live animal market) and

GATHERING_AREA_TYPE_WATER.shp (WATER: water points) with the tool

Add vector layer ( ).

NB For greater clarity, delete the old layer GATHERING_AREA .

Animal mobility parameters: degree and betweenness centrality Import the animal mobility
layer that you created when you classified the risk factors: degree and betweenness centrality.

Let’s gather all the data in the same shapefile

Animal density of cattle and small ruminants (goats/sheep). Animal density was added to
the layer defining your administrative divisions. We will start from this layer representing the
administrative divisions of Tunisia as well as the animal density associated with each of these
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administrative divisions. We will call it the main layer in the rest of the exercise. We are going to
add to this layer the other risk factors of exposure: road density, the different gathering areas and
the animal mobility parameters.

Road density~���1 Open the attribute table of your road density layer.~���2 Activate the ‘Toggle Editing’ mode.~���3 Delete all of the columns except the column “DENS_ROAD”.~���4 Leave the ‘Toggle Editing’ mode and save your changes.~���5 Close the attribute table.

~���6 Make sure that no feature is selected ( ).

~���7 Go to the menu Vector » Data Management Tools » Join attributes by location ( ).
Define the following parameters:
• Input vector layer: Select your main layer.
• Join vector layer: Select the layer containing the road density calculated for each

Tunisian delegation.

• Geometric predicate: Only tick the box Equals .
• Precision: Leave 0.
• Attribute summary: Select Take attributes of the first located feature .
• Statistics for summary: Enter nothing (this frame is only used if you wish an attributes

summary).

• Joined table: Select Keep all records (including non-matching target records) .
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~���8 Click on Run to launch the creation of a new layer containing road density and animal

density. Save your Joined layer as a shapefile (right click on the name of the layer in the

legend » Save as... ). This is now your new ‘main layer’.~���9 Explore its attribute table.

NB You can delete the animal density and road density layers and the joined layer. You
now have all of this information in your new main layer.

Gathering areas: water points, live animal markets, fattening units We wish to know how
many gathering points of each type are contained in each administrative division. We are therefore
going to count them.

~���1 Use the menu Vector » Analysis Tools » Count points in polygon .

~���2 Define the following parameters:
Polygons: Select your main layer.
Points: Select the water points layer.

Count field name Set the name of the new column. For example: WATER .

~���3 Click on Run .
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A new layer ‘Count’ was generated in which your column was added. Save this new layer as a
shapefile: This is your new main layer. Repeat the operation for the fattening units and the live
animal markets. Remember to select the new layer as the main layer and to put a different column

name, for example: FATTENING .

You now have in the same layer information concerning animal density, road density, and the
gathering areas of live animals. Do not hesitate to delete the old layers

Animal mobility parameters: degree and betweenness centrality All that remains is to add
to each administrative division the degree and betweenness centrality associated with it.

To do so:~���1 Open the attribute table of the mobility data layer.~���2 Activate the ‘Toggle Editing’ mode.~���3 Delete all of the columns except the “maxdegree” and the “maxbetween” columns.~���4 Leave the ‘Toggle Editing’ mode and save your changes.~���5 Close the attribute table.

~���6 Make sure that no feature is selected ( ).

~���7 Go to the menu Vector » Data Management Tools » Join attributes by location ( ).
Define the following parameters:
• Input vector layer: Select your main layer.
• Join vector layer: Select the layer containing the mobility parameters.

• Geometric predicate: Only check the box Equals .
• Precision: Leave 0.
• Attribute summary: Select Take attributes of the first located feature .
• Statistics for summary: Enter nothing (this is only if you wish an attributes summary).

• Joined table: Select Keep all records (including non-matching target records) .



114 Chapter 9. Application of the method: case of Tunisia

~���8 Finally, click on Run to create a new layer containing the data on animal and road densities,
the different live animal gathering areas and the animal mobility parameters.~���9 Rename your Joined layer and save it as a shapefile (right click on the name of the layer

in the legend » Save as... ). This is your new main layer, the one that you will use for the
actual mapping.~���10 Explore the attribute table of your new main layer.

NB Once again, for greater clarity, you can delete the old layers.

Let’s map the risk of exposure of foot-and-mouth disease

You can now map the levels of risk of exposure to foot-and-mouth disease in Tunisia! We will
highlight the administrative divisions associated with each level of risk of exposure.

~���1 Open the attribute table of your main layer.~���2 Create a new field in which the level of risk of exposure will be defined.
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(a) Activate the ‘Toggle Editing’ mode.

(b) Add a new field.

(c) Name this field ‘Expo’.

(d) Define it as a ‘Whole number (integer)’,

(e) with a length ‘1’.

NB We are going to discriminate four levels of risk
1 ⇒ Risk Negligible

2 ⇒ Risk Low

3 ⇒ Risk High

4 ⇒ Risk Very High

(f) Validate by clicking on OK .

~���3 We now will update this field using the field calculator . Check that no row is selected

( ) and click on the icon: .
We will use an expression describing the criteria characterizing very high risk, high risk and
low risk. The administrative divisions that do not meet any of these criteria will present a
negligible risk.
Remember our characterization of risk levels:
• If animal density of an administrative division is very high AND there is at least one

live animal market, OR if road density OR degree OR betweenness centrality is very
high, OR if the administrative division contains a fattening unit OR a water point, then
it is considered to present a very high risk (4) for exposure to FMD.

• Otherwise, among the remaining administrative divisions, if animal density is very high,
OR if animal density is high in the presence of a live animal market, OR if road density
OR degree OR betweenness centrality is high, then it is considered to present a high
risk (3) for exposure to FMD.

• Otherwise, among the remaining administrative divisions, the risk is low if animal
density is high, OR animal density is low in the presence of a live animal market, OR
if road density OR degree OR betweenness centrality is low, then it is considered to
present a low risk (2) for exposure to FMD.
• All other administrative divisions are considered to present a negligible risk (1) for

exposure to FMD.
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Characterization in EXPRESSION

if (( "Rum_dens_m" > 116.14 AND "MARKET" > 0) OR

"Roads_dens" > 1.255 OR

"maxdegree" > 10 OR

"maxbetween" > 10.792 OR

"FATTENING" > 0 OR

"WATERING" > 0,

4,

if( "Rum_dens_m" > 116.14 OR

("Rum_dens_m" > 82.36 AND "MARKET" > 0) OR

"Roads_dens" > 0.7655 OR

"maxdegree" > 5 OR

"maxbetween" > 4.208,

3,

if( "Rum_dens_m" > 82.36 OR

("Rum_dens_m" > 39.31 AND "MARKET" > 0) OR

"Roads_dens" > 0.4688 OR

"maxdegree" > 1 OR

"maxbetween" > 0,

2,

1

)))

~���4 In the field calculator:

(a) Tick ‘Update existing field’.

(b) Select the field ‘Expo’.

(c) Copy the expression above in the dedicated frame (empty frame under ‘Expression’).

(d) Click on OK.

~���5 Close the ‘Toggle Editing’ mode and save your changes.
All you have to do now is change the Style of your layer to produce your final map of the
risk of exposure.~���6 Right click on the main layer.~���7 Click on Properties .

~���8 In the Style tab:

(a) Select Categorized .

(b) Select the column Expo in which you have updated the level of risk.

(c) Click on Classify .

(d) Adjust the legend and the colours.

(e) Click on OK .
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Exercise 9.18 Do this 4th step for your country.

NB Do not hesitate to help yourself with the video and slide presentation available. If you
encounter difficulties, also remember to contact the team of trainers for help.

�

Congratulations, if you have successfully completed all of these steps, you have produced a
map of the risk of endemicity and spread of an animal disease in Tunisia! It is now up to

you to do the analysis for your territory!!
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List of risk factors

These lists are not comprehensive. They are meant to be completed and adjusted according
to your territory, livestock systems, import policy, etc., but you can learn from them to
determine the major risk factors in your country.

Geographic factors

• Climate
• Habitats, use of territories
• Densities
• Wildlife
• Vectors

Host factors

• Species
• Ages
• Behaviours

Livestock farm factors

• Biosecurity
• Management
• Live animal market
• Water points
• Animal density
• Feed
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Mobility and trade factors

• National and international flows
Transhumance corridors-these are corridors of pastoral passage (the mobility of

animals and their pastoralists), within a territory or cross-border, motivated by a search
for pastures and water points, as well as to escape epizootic outbreaks or to engage in animal
trade.

Degree-the number of direct connections of a site (e.g. a market with extensive
exchanges of animals with other markets).

In-degree-the number of direct connections that enter a site (e.g. a flow of animals
heading to a market).

Out-degree-the number of direct connections that leave a site (e.g. a flow of animals
heading away from a market).

Betweenness centrality-the shortest path between nodes (e.g. a market – hub that
connects other nodes together).
• Road accessibility is a measure of the average travel time (in minutes) and average speed

(in kilometres / hour) relative to the size of administrative divisions.

Health risks

• Past cases
• History of risky practices

Importing country’s surveillance activities Epidemiological surveillance
is an observation method based on continuous recordings to monitor the state of
health or risk factors of a defined population, in particular to detect the emergence
of pathological processes and study their development in time and space, in view of
adopting appropriate control measures.

Epidemiovigilance
is a type of epidemiological surveillance aimed at early detection, followed by monitoring
the evolution of diseases considered high-risk and capable of causing disasters in a
country in the region for prevention and control actions.

Epidemiological unit
refers to groups of animals/herds with a defined epidemiological link, characterized
by a similar probability of exposure to a pathogen, either because they share the same
environment or because they belong to the same management system.

Control policy of the importing country
refers to programs approved, managed or supervised by the Veterinary Authority of a country
to control a vector, pathogen or disease, applying specific measures over the entire country,
or only in a given area or compartment of its territory.

Animal health status of the importing country
means the status of a country or area with respect to a given animal disease according to
the criteria in the chapter of the Terrestrial Code (OIE Terrestrial Animal Health Code)
corresponding to this disease.



Data collection on animal mobility

Example of survey aiming to collect data on animal mobility in Mauritania

Objective

The final objective is to map the movements of ruminants – cattle, sheep, goats, and camelids – at
the scale of Mauritania. The ensuing sub-objectives are:
Objective 1 Establish a map of movements (legal and illegal, cross-border) by species and by

month;
Objective 2 Make a list of gathering areas: markets, fattening sites, rest areas, slaughterhouses,

farms;
Objective 3 Estimate the areas at risk (incoming, outgoing). Modelling (Vmerge project).

Protocol

There is little available information about ruminant movements at the level of the DSV or DIREL
in Mauritania. Knowledge regarding collective livestock movements can be acquired through more
or less complex surveys. These are summary type surveys. Such surveys provide good spatial
representativeness in terms of movements. Analyses based on animal movements can take into
account both individual and collective flows. The task is not to make a count, but rather to interview
a butcher, head veterinarian, or market manager who has a global understanding of the incoming
and outgoing flows in the region. This will provide information on the origin and destination as
estimates for each species. The result will be a map of different movements with a description of
the intensity of flows but not a headcount.

Choice of itineraries

The bibliography (Figure1), the extensive field knowledge of the veterinarian services, and the
disease outbreaks identified over recent years make it possible to identify the areas to survey.
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Figure 9.1: Trade and transhumance livestock routes in West Africa. Source: Atlas des évolutions
des systèmes pastoraux au Sahel (Touré et al., 2012).

As can be observed, most ruminant (cattle, sheep, goats) trade exchanges occur along the
borders with Senegal and Mali. For camelids, trading mainly takes place in the north towards
Morocco, and is often uncontrolled.

The following areas were identified:

• North (mainly camelids): Atar / Zouerate towards Morocco.
• Centre: Kendelec (“Lake Camp”) resting area 50 km from Boutlimit and Aleg. Tidjikda.
• Southeast (Mali border) Important trade exchanges between Ajoun, Kobeni, Touil then Néma

towards Bassiknou, Adel Bagrou, Boustaile, Djguenni and Timbedra
• South (Senegal border) Rosso-Sélibali
• West: Nouckchott / Nouadhibou (“cul de sac”)
• The desert areas in the north and east were not surveyed.

From this, one can identify the survey itineraries, presented in Figure 9.1.

Itinerary 1 Mission Nordwest: Nouakchott / Akjoujt / Atar / (8 days)
Itinerary 2 Mission Centre: Nouakchott / Boutlimitt / Aleg / Tidjikja (5 days)
Itinerary 3 Mission Southeast: Nouakchott / Kiffa / Ajoun / Néma / Bassiknou / Adel Bagrou /

Boustaïle / Djiguenni / Timbedra (10 days)
Itinerary 4 Mission South: Nouakchott / Rosso / Bogué / Kaédi / Sélibabi (6 days)

For Nouackchott, the surveys will be conducted through local services (regional inspectors, livestock
department, markets and Nouackchott slaughterhouse company). For Nouadhibou, either a short
mission of one or two days could be planned or contact made by telephone.

Mission Northwest 2500 8
Mission Centre 1200 5
Mission Southeast 3000 10
Mission South 1400 6
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Figure 9.2: The four selected itineraries.

The questionnaire

For this study, a survey questionnaire was designed and is presented below.

This questionnaire includes questions on the origin and destination of livestock.

The data collected include the date of the interview, as well as the periods (Tabaski, dry season),
and usual or exceptional routes over the year, with their frequency (daily, weekly, monthly, annual).
To these data are added an approximate number of livestock (estimated), the species concerned, the
mode of transport and possibly the duration. Expected in response, for a given month or a given
period, is a list of locations with their type (market, livestock farm, or other), and for each of the
places, an approximate number per species. If the movement is in stages, the transit locations are
noted.

As the travelling time is not always known, this can be deduced from the mode of transportation
and the distance. The same holds for the unloading or not of animals; one can decide if there are
transit stages or if the duration is greater than one day, there is “unloading”.
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Conducting the surveys

The duration of the field missions varies depending on the itinerary.

A meeting with the heads of veterinary posts is planned. The survey takes place in the form of
a face-to-face interview.

This will provide the origin and destination in the form of estimations for each species. During
these interviews, the transhumance certificates or summary booklets that list the origin, transit,
destination, type of conveyance, species and an approximate number of heads also will be recovered.

The interviewers may be required to supplement the information by visits to markets or
slaughterhouses to interview different actors (farmers, butchers, managers of rest areas...).

The interviewers can be equipped with a GPS to geo-locate all of the areas investigated, but
we already have the geolocations of the selected sites. The questionnaire could be translated into
Wolof, Peul, Serrer. . .

Data processing

In Nouackchott, questionnaire data will be entered in an Excel spreadsheet whose structure has
been previously established.

The data will then be transferred by CIRAD into an information system and can then be
cross-linked with other data such as the results of the serological, virological and molecular
analyses.

Calendar and budget

Calendar

• One week of field mission preparation (coordination, correspondence with local government,
meeting with heads of the veterinary posts)
• Four missions for a total of 29 days and 8100 km
• Data entry

Trips Km Duration in days
Mission Northwest 2500 8
Mission Centre 1200 5
Mission Southeast 3000 10
Mission South 1400 6
Total 8100 29
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Animal mobility survey budget

Item Cost in UM Euros
Fuel: 17 litres / 100 km *
80 (8,000 km ) * 400 UM /
l diesel

544 000 1 480

Vehicle maintenance
(oil package. . . ) 12 000
UM/mission

48 000 131

Travel allowance for 1 driver
(5 000F UM/day) over 29
days of travel

145 000 394

Travel allowance for 1
epidemiologist (18 400
UM/day) over 29 days of
travel

533 600 1 451

Data entry (2 months) 50 000
UM/month/person

100 000 272

Photocopies (10 000
UM/mission)

20 000 54

Cash in advance for expenses
during the mission (incentives,
coffee break,. . . )

200 000 544

Total 1 590 600 4 326

Vehicle and GPS belonging to veterinary services.
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Example of survey aiming to collect data on illegal/undeclared movements

Illegal movements (breeders/fatteners)
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Illegal movements (vétérinaires)
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Illegal movements (farmers/traders)
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